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1.1 General Description 
 A powerful computer program should be founded on advanced theory and be verified by tests 
and practice. The DYNAN program follows these guidelines. DYNAN is based on the improved Novak’s 
method where a non-reflective boundary is formed between the near field and the far field to account 
for the mass of soil in the boundary.  The program yields the dynamic response of both shallow and 
deep foundations under harmonic, transient, and random loadings. Such loadings can be produced by 
rotating or reciprocating machines, earthquake, wind, blast, sea waves, and other sources.  

 The foundations (or caps on piles) are assumed to be rigid, and all six degrees of freedom are 
considered as coupled. The foundation stiffness and damping constants are also returned for possible 
use in soil-structure interaction analyses. 

 The stiffness of the supporting soil along with damping constants needed for the analysis are 
evaluated in the program for surface foundations, embedded foundations, and pile foundations. Soil 
layering, a possible weakened zone (see Fig. 5.3) around a foundation, and pile-soil-pile interaction are 
all taken into account. Dynamic experiments have been done on full-scale shallow foundations and pile 
foundations to investigate the soil-structure interaction. DYNAN program was developed based on the 
impedance function method and used the model of soil-structure interaction with nonreflective 
boundary between the near field and the far field to account for the nonlinearity of soil. 

 

1.2 Application of Program  
 The computational method has been applied to many important problems in engineering 
practice (Han, 1987, and Han, et al, 1999). To investigate soil-structure interaction, a series of dynamic 
experiments were performed on full-scale mat foundations (Han, 1989) and on full-scale piles (Han and 
Novak, 1989, 1992). The elastic wave energy from foundation vibration was dissipated in three 
dimensions as radiation damping. The soil is not a perfect elastic medium as assumed in the theory and 
the experiments showed that damping was overestimated in the computation. For practical purposes, 
the damping is reduced in DYNAN based on experimental results.  
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To match more rigorous solutions, the theory of soil reactions is modified in the low frequency 
range. At the dimensionless frequency a

0
 = ωr/V

s
 less than 0.3 for piles under lateral loading, the soil 

stiffness is taken as constant and the damping is taken as linear (ω is the circular frequency in rad/s, r is 
the pile radius and V

s
 is the soil shear-wave velocity). In general, the dynamic stiffness of soil is close to 

the static stiffness in the low frequency range (less than 0.05 Hz). 

 DYNAN can be used for the dynamic analysis under transient and random loading in the time 
domain (see Han and Cathro, 1997). It also can be used for harmonic loading in the frequency domain. 
The substructure concept based on the impedance function of foundations has been introduced in the 
structural analysis and is frequently used by the structural engineers for the time-history analysis in 
seismic studies. By means of a substructure method, the dynamic response of superstructure is 
calculated using a finite element program, such as SAP2000, and the stiffness and damping of 
foundation generated by the DYNAN program (see Han, 2001) are used for representing the foundation 
reaction.  

 

1.3 Program Features  
Program DYNAN 3.0 was developed based on MicroSoft Windows operation systems and uses a 

graphics interface for data entry.  The user may read the screen information, then type the data at the 
specified entry field. The entered data can be changed freely by moving the mouse to the field location 
on the screen.  

DYNAN 3.0 integrates the input modules, main-computation module, and graphics module into 
one system. Therefore, the user may freely call each module inside Windows for operation. In general, 
after entering the input data , the user may call the computation module to execute the input data. The 
user may also call on the graphics module to plot the computed pile-head stiffnesses versus loading 
frequencies.  

• The program employed well-established analytical solutions for soil-structure interaction under 
dynamic loading condition.  

• The program can analyze four types of foundations: (1) footing on homogeneous half-space 
(half-space option); (2) footing on homogeneous layer (stratum option); (3)footing embedded in 
layered medium (multilayer option); and (4) deep foundation (pile option).  

• The program was developed based on the improved Novak’s method and a non-reflective 
boundary is formed between the near field and the far field to account for the mass of soil in the 
boundary zone.  

• The foundations (or caps on piles) are assumed to be rigid, and all six degrees of freedom are 
considered as coupled.  

• The group effect of piles is accounted for by using the method of interaction factors in the 
DYNAN program.  

• In DYNAN, the harmonic excitation can be of two types: constant amplitude excitation and 
frequency-dependent or quadratic excitation.  

• The program accepts either S.I. units or English units.  
• DYNAN can be used for the dynamic analysis under transient and random loading in the time 
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domain (see Han and Cathro, 1997). It also can be used for harmonic loading in the frequency 
domain.  

• The program generates the output data for each frequency of harmonic loads on the 
foundation.  

• The Graphics menu allows quick observations of results contained in the output file.  
• The files of input data and output data are text based and may be directly accessed from within 

the DYNAN program, employing the user's preferred text editor or word processor.  
• A well-documented manual is provided with the relevant theoretical background and guidance 

to input screens.  
 

1.4 Units, Notation and Sign Convention  
Any unit notations may be used, but the notations must be consistent. The output calculated 

should be of the same unit notation as that of the inputed data. Consider that in the SI measuring 
system, the units for measuring force, mass, length, and time are, respectively, kN, Kg , m, and s, where 

Mg = 1,000 Kg and gravity = 9.81 m/s
2
. For the English measuring system, the units are lb, slug, ft, and s, 

where gravity = 32.2 ft/ s
2
, and mass slug = lb/32.2.  

The input forces, moments, and response components follow the sequence of labels shown in 
Fig. 1. For instance, labels 1 and 2 indicate horizontal direction along the X and Y axes. The force and 
moment are defined with regard to the center of gravity (C.G.).  The ‘center of gravity’ means the center 
of gravity of the machine/foundation system. X

c
, Y

c 
and Z

c
 are the coordinates for the center of the 

foundation base, (C.B.).  

The forces and translations are positive if they move in the positive direction of the 
corresponding axis. When being observed from the origin in a positive direction of the pertinent axis, 
moments and rotations are positive if they act in a clockwise direction . Thus, two positive horizontal 
forces P

1
 and P

2
 acting above the C.G. in the direction +X, +Y result in moments M

4
 < 0 and M

5
 > 0. 

Stiffness constants, defined to be external forces, follow the same sign convention; consequently, the 
cross-stiffness constants of symmetrical foundations differ in signs.  

 

1.5 Company Background  
Ensoft, Inc., USA signed an agreement with Dyna Tech (Canadian Company) to develop a Windows-
based pre- and post- processor for operating DYNAN on a Windows platform.  The computation code of 
DYNAN has been copyrighted and registered with Canadian Intellectual Property Office in July 2001.  
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 Figure 1.1   Notation and sign convention used by DYNAN 3.0 

 

Both Dyan Tech and Ensoft cannot take responsibility for correct results from the codes; hence, 
the user is to employ independent means, such as calculations by hand, to verify the results of any 
computation. Hand calculations made by knowledgeable engineers employing basic engineering 
principles may yield approximate values for comparison with values from computer codes, even for 
complex problems. Both companies are committed to continuing the development and maintenance of 
the usefulness and availability of the program for businesses and professionals.  
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2.1 Installation Procedures 
Program DynaN 3.0 is distributed with a hardware lock (USB dongle). The hardware lock consists 

of an electronic device that is attached to the USB port of the computer in use. This method of software 
protection has been found to provide compatibility with existing operating systems, better stability than 
other alternatives, and it allows users to obtain software updates or replacements via downloads from 
the internet.  

The file setup.exe, contained in the distribution media, is a Windows-based program which will 
assist the user in installing all the program modules into an user-selected directory with all the proper 
settings used for the Windows environment. The user is assumed to have the basic knowledge for 
running applications under Windows. The following steps are recommended for a successful installation.  

2.1.1 Installation of Single-User Version  

Users are normally supplied with software manuals (in electronic pdf format), CDROM, and USB 
dongle. This version of DynaN has been tested to be compatible with the following versions of Windows: 
Win 2000, Windows XP,  Windows Vista,  and Windows 7.  

The following guidelines are recommended to be followed during the installation process of DynaN v3.0 
for single-user licenses.  

 
1. It is our recommendation that the hardware lock (USB dongle) should not be plugged in the 

computer prior to the software-installation process.   The USB dongle can be plugged into the 
computer after the software has been installed successfully and the computer should recognize 
the USB device immediately.  

 
2. Start Windows. ®  Insert the distribution CD-ROM in the appropriate tray.   If the main 

installation program does not start automatically, click on the Start button and select Run.  On 
the command line, type d:\setup.exe or e:\setup.exe, where d: or e: represents the drive that 
contains the distribution CD. Press e or click OK to execute the command and start the main 
installation program for ENSOFT’s software.  A screen similar to the one in Figure 2.1 should 
appear.  

 

3. Click anywhere on the DynaN 3.0 icon and then click on the Install Standard button to start the 
installation of the single-user version of DynaN v3.0.  

 

4. The user should read the license agreement shown in Figure 2.2.  Please click “Yes” if you agree 
and would like to proceed. 

 
5. The user will be provided with an option to select a drive and directory for the installation of 

DynaN 3.0; the default is c:\Program Files\ensoft\DynaN. If the desired directory does not exist, 
the installation program will automatically create a new directory in the chosen hard drive.  
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Figure 2.1   Main installation screen for ENSOFT software (may change with time)  
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Figure 2.2   Main installation screen for ENSOFT software (may change with time)  

 

 

Figure 2.3   Main installation screen for ENSOFT software (may change with time)  
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If your license is for a single-user, select the "Single-User License" option and click Next.  Follow the 
dialog boxes until the installation finishes.  After the installation is completed, insert the USB dongle into 
any USB port and follow USB driver installation if it shows up.  In some cases, the user may be requested 
to restart Windows before executing the program. 

6. Most distribution files will be copied to the installation directory (either the default or the one 
selected by the user). However, certain files are copied to system directories in Windows and some 
Windows services are started during installation.  

7. After the installation is finished, it is usually not necessary to reboot Windows for the program to run. 
The user may plug the USB dongle into the computer and run the program by double-clicking its icon in 
the ENSOFT/DynaN folder located in the Start/Programs menu.  

2.1.2 Network License 
Special network licenses and hardware locks are available for users that desire to operate 

DynaN 3.0 on a Windows network. The network version is limited to users with two or more licenses at 
the same physical site. Discounted rates apply for users purchasing multiple licenses for the same site.  

Network versions of DynaN 3.0 have special subroutines written for installations in “software 
servers” and for installations of “individual clients”.  
 

The  “software server” is known as the computer that will be carrying the network lock provided 
by ENSOFT, INC.  The software server is not necessarily the same as the existing network server. Any 
computer in the existing Windows network may be designated software server for DynaN 3.0 as long as 
the network lock is attached to its USB port and the “server” version of the software is installed in its 
hard drive.  

Software “clients” may be all other computers of the network that have the program installed as 
clients. Software clients do not need any hardware lock attached to their USB port. The program 
installed in “software clients” will be allowed to run as long as the computer designated as “software 
server” is running on the network with the proper operating system and with its network USB lock 
secured in the appropriate place.  

Users of the network version of DynaN 3.0 are allowed to have the software installed in as many 
computers as they have on their local Windows network.  However, only a number of users equal to the 
total number of purchased licenses (minimum two for networks) will be able to operate the program at 
the same time.  

2.1.3 Installation of Network Version  
 To install this program, the user must have network privileges to modify the Windows registry.  
In large computer networks, this is usually only available to network administrators. They are the ones 
recommended to proceed with these installations.  

1. The network administrator must first define the computer that will be carrying the network lock 
(USB dongle) for this software. The computer carrying the network lock is known as the "server" 
for this particular computer program. Notice that the "server" may be any computer in the 
network, and not necessarily the existing file server or network server.  
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2. INSTALLATION TO A "SERVER": Please attach the USB dongle to any USB port of the software 
server.  The "server" computer must be turned on and logged into the network to enable other 
users (ie, "clients") to access this computer program.  

3. INSTALLATION TO "CLIENTS": It is not necessary to connect the USB dongle to client computers 
during installation nor during program executions. Once the program is executed, the installed 
network protocols will automatically recognize the computer where the network key is residing 
and the number of simultaneous users.  

4. Start Windows and Insert the distribution CD-ROM in the appropriate tray.  

5. If the main installation program does not start automatically, click on the Start button and select 
Run.  On the command line, type d:\setup.exe or e:\setup.exe, where d: or e: represents the 
drive that contains the distribution CD. Press e or click OK to execute the command and start the 
main installation program for ENSOFT’s software.  A screen similar to the one previously shown 
in Figure 2.1 should appear.  

6. Click anywhere on the DynaN 3.0 icon and then click on the Install Network button to start the 
installation of the network version of DynaN v3.0.  

7. The user will be provided with an option to select a drive and directory for the installation of 
DynaN 3.0; the default is c:\Program Files\ensoft\DynaN. If the desired directory does not exist, 
the installation program will automatically create a new directory in the chosen hard drive.  

8. The installation program will automatically recognize the version of Windows that is running in 
the destination computer.  The user will be prompted to select an installation to a Client or to a 
Server computer.  If desired, the network administrator may install the program to a single 
directory in a file server.  In this case, the software must first be installed in the file server as a 
“software server” and icons pointing to the DynaN.exe file (residing in the server) can later be 
created in each individual client computer.  

9. Most distribution files will be copied to the installation directory (either the default or the one 
selected by the user). However, certain files are copied to system directories in Windows and 
some Windows services are started during installation.  

10. After the installation is finished, it is usually not necessary to reboot Windows for the program 
to run. The user may run the program by double-clicking its icon in the ENSOFT/DynaN folder 
located in the Start/Programs menu.  

2.1.4 Backup of Original Software  
The distributed software may be copied for backup purposes. The program may be installed in 

several computers at the same time. However, unless netwrok licenses are purchased, the program will 
only operate in computers that carry the appropriate USB lock.  
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2.1.5 Software Updates on the Internet  
Occasionally, ENSOFT will produce software improvements and/or fixes and place the latest 

software programs on ENSOFT’s internet site. Software users may download the latest program update 
from the following site if the user has the valid maintenance policy:  

http://www.ensoftinc.com  

 

2.2 Getting Started 
 A general diagram showing the menu choices and operational flow chart of program DynaN 3.0 
is presented in Fig. 2.4. The following paragraphs provide a short description of the operational features 
and should quickly enable the user to get started with the program.  

2.2.1 Starting the Program  
 The program is started by double clicking the left mouse button anywhere in the DynaN 3.0 
icon. A new window will appear on the screen, with several top menu choices: File, Data, Computation, 
Graphics, View Geometry, Window, and Help. As a standard Windows feature, all underlined letters of 
top menu operations indicate that choices may also be accessed by keyboard combinations of alt+ 
[letter] (where [letter] represents the desired underlined letter).  
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Figure 2.4   Main installation screen for ENSOFT software (may change with time)  
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2.2.2 File Management  
 The Filemenu contains four submenus, followed by a list of the last four recently-opened files, 
and an option for exiting the program. A sample of submenu options are included in Fig. 2.5. A brief 
description of submenu choices follows below:  

• New : to create a new data file.  

• Open...: to open an existing data file.  

• Save :  to save input data under the current file name.  

• Save As...:to save input data under a different file name.  

• Exit : to exit the program.  

The last four files that were opened recently are also listed under the File menu. Clicking on any of the 
four files opens the selected file and instructs the program to use the directory of the opened file as the 
location for creating all output files.  

 

Figure 2.5   Options contained in the File menu  
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Several additional files are created in every new DynaN 3.0 run. A short description of these files is 
presented in Table 2.1. In general, every successful run generates five?? text files in the same drive and 
directory where the input-data file was saved. Any of these files may be opened with standard text 
editors or word-processing programs.  

Table 2.1  Files created in standard DynaN 3.0 runs  

 

 

 

 

 

 

 

2.2.3 Data Input of Application Problem  

 The Data menu contains several submenus, as shown in Fig. 2.6. The submenu choices are listed 
below, along with a general description of their use.  
 

• Title : to input the project description.  
• Units : this option allows the user to select either English Units (using pound and foot, and slug), 

S. I. Units (using kiloNewtons, meters, and Mg), or any other consistent set of units of Force and 
Length. English units are enabled, as a default, for all new runs. The user may change the system 
of units as many times as desired, and values that were previously inputted will be automatically 
converted by the program from English to S.I. units or viceversa.  

• Option of Foundation System : to select one of four available foundation types, i.e. half-space, 
stratum, multi-layer, and pile.  

• Option of Loading : to select one of three available loading types, i.e. harmonic loading, 
transient loading, and random loading.  

• Option of Foundation Shape : to select a circular foundation or a rectangular foundation.  
• Footing Mass parameters : to input mass moment of inertia, total mass, and cross-product of 

inertia.  
• Foundation Dimension and Constants : to input the foundation dimension related to the center 

of gravity.  
• Foundation Layer : this submenu is used to enter the soil layers and soil properties for the multi-

layer type of foundation.  
• Pile Cap Shape/Dimension : to select a circular pile-cap or a rectangular pile-cap.  
• Pile Cap Mass Properties : to input mass moment of inertia, total mass, and cross-product of 

inertia of the pile cap. 

File Name  Usage  File  Example  
Extension  Description  Format  Files  
*.dnd  Input-data file  Text file  example1.dnd  
   example2.dnd  
*.dno  Output-data file  Text file  example1.dno  
   example2.dno  
*.dnp  Plot-data file  Text file  example1.dnp  
   example2.dnp  
*.dnr  Processor-data file  Text file  example1.dnr  
   example2.dnr  
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• Pile Coordinates : to input the pile-head coordinates and battered angle for each pile.  
• Pile Properties : to input the material properties, [the] pile-cap dimension related to the center 

of gravity, pile length and other pile-related data.  
• Pile Elements : to input the radius, moment of inertia, layer increments, and torsional 

coefficient.  
• Soil Layer Data : to input the properties of soils that are next to the side of the foundation. The 

parameters of [the] weak zone in the side soil can be specified. 
• Soil Data Below Footing/Pile Tip : to input the properties of the soil that are below the footing 

or pile tip.  
• Side Soil of Pile Cap : to input the properties of soils that are next to the side of the pile cap. The 

parameters of the weak zone in the side soil can be specified.  
• Soil Column Layer : to input the properties of the soil layers that are below the multi-layer type 

of foundation.  
• Harmonic Loading Data : this submenu is used to input data for harmonic loading.  
• Transient Loading Data : this submenu is used to input data for transicent loading.  
• Random Loading Data : this submenu is used to input data for random loading.  
• Control Options : this option provides a window submenu where the user may select the 

available software as the text editor for input and output files. The user should input in this box 
the complete path and command line for the preferred text editor or word processor that will 
be used to examine and print the input, output, and processor plain text files created by the 
program. As a default, the command line c:\windows\notepad.exe is used to operate the 
standard text editor Microsoft Notepad included with Windows 2000, Vista, XP or 7. However, 
there may be some instances when the output files are too large for Notepad and a different 
text editor or word processor should be used. In such cases it is generally suggested to use 
Microsoft WordPad (c:\windows\write.exe).  
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Figure 2.6   Options contained in the Data menu  

 

2.2.4 Computation Options  
 The Computation menu is provided to run the analytical computations after all data are entered 
and saved. After the computation is executed successfully, this menu additionally provides options for 
the reviews of plain-text input data, notes produced during computation, and output data. It also 
provides an option for graphical observation of the automatically-generated meshes. Submenu choices, 
shown in Fig. 2.7, are briefly described below.  
 

• Run Analysis : this option is chosen to run the analytical computations. This option should be 
selected after all data have been entered and saved.  

• Edit Input Text : this option calls the previously-chosen Text Editor (selected under the Control 
Options submenu in the Data menu) to observe and/or edit the analytical input data in plain-
text format. The option becomes available after the input data has been saved to disk, or when 
opening an existing input-data file.  

• Edit Processor Run-Note : this option calls the previously-chosen Text Editor (selected under the 
Control Options submenu in the Data menu) to observe and/or edit the error message in plain-
text format if the program can not be executed.  

• Edit Output Text : this option calls the previously chosen Text Editor (selected under the Control 
Options submenu in the Data menu) to observe, format, and/ or print the analytical-output 
data. The option becomes available only after a successful run has been made. Certain output 
files may be too large for the Microsoft Notepad editor, so other text editors would have to be 
used (Microsoft WordPad should be able to open most text files).  
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Figure 2.7   Options contained in the Computation menu  

 

2.2.5 Graphics  

 The Graphics menu is used to observe plots of output data provided by a successful program 
run. Options for the observation of output curves under this menu are only enabled after a successful 
run has been made. Even after performing successful runs, some options may still be disabled since the 
required amount of output data depends on specifications provided in the input file of each program 
run.  
 
Submenu choices, shown in Fig. 2.8, are briefly described below.  

• Translation Stiffness (Kxx, Kyy, and Kww) : this option provides a plot of translation stiffness in 
the x-direction, y-direction, and z-direction of the foundation vs. loading frequencies.  

• Rotation Stiffness (Kppx, Kppy, and Kzt) : this option provides a plot of rotational stiffness 
about the x-axis, y-axis, and z-axis of the foundation vs. loading frequencies.  

• Translation Damping (Cxx, Cyy, and Cww) : this option provides a plot of translation stiffness in 
the x-direction, y-direction, and z-direction of the foundation vs. loading frequencies.  

• Rotation Damping (Cppx, Cppy, and Czt) : this option provides a plot of rotational stiffness 
about the x-axis, y-axis, and z-axis of the foundation vs. loading frequencies.  

• Footing Response Amplitude (Translation) : this option provides a plot of translation amplitude 
in the x-direction, y-direction, and z-direction of the foundation vs. loading frequencies at c.g. 
location.  

• Footing Response Amplitude (Rotation) : this option provides a plot of rotation amplitude 
about the x-axis, y-axis, and z-axis of the foundation vs. loading frequencies at c.g. location.  
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• Interactive Footing Response Amplitude : this option provides a plot of translation/rotation 
amplitude about the x-axis, y-axis, and z-axis of the foundation vs. loading frequencies at the 
user specified location.  

 
 

 
 

Figure 2.8   Options contained in the Graphics menu  

 

2.2.6 Arrangement of Windows  

 The Window menu provides two standard functions for organizing open-screen windows and/or 
minimized screen-window icons. Submenu options, shown in Fig. 2.9, are briefly described below.  

• Cascade : this option organizes all open-windowed menus so that all become visible with their 
tops cascading from the upper left portion of the screen.  

• Arrange Icons : this option organizes the icons of all minimized windowed menus so that all 
become visible and align at the bottom portion of the screen.  
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Figure 2.9   Options contained in the Window menu  

 

2.2.7 Help Files  

 The Help menu provides an online help reference on topics such as: using the program, entering 
data, information about variables used in the program, and methods of analyses. Submenu options, 
shown in Fig. 2.10, are briefly described below.  The Help menu may be accessed at any time while in 
DynaN.  

• Contents : the main reference files for help are accessed through this submenu option. Clicking 
on this option provides a screen with reference help for the following topics: File Menu, Data 
Menu, Computation Menu, Graphics Menu, and Help Menu. Under each topic are additional 
subtitles that correspond to data-entry headings. If the user selects one of these, a help screen 
on the topic is displayed.  

• About : this provides a screen describing the program version, date, and methods for accessing 
technical support.  
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Figure 2.10   Options contained in the Help menu  
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3.1 File Menu 
 This menu contains options related to the management of input-data files and exiting the 
program. Input-data files created for DynaN 3.0 are provided with a standard file-name extension in the 
form of *.dnd (where * represents any acceptable file name). All input-data files are standard text files 
and may be edited with any text editor or word-processing program.  

3.1.1 File -New  

 Once the program is started, default values are used for certain operating parameters, and a 
blank input-data file is created. Selecting New under the File menu resets all DynaN 3.0 variables to 
either default or blank values, as appropriate. This option should be selected when desring to create a 
new data file from a blank form.  

3.1.2 File -Open  

 This is used to open a file that had been previously prepared and saved to disk. The File -Open 
window dialog, shown in Fig. 3.1, is used to search for an existing input-data file. By default, the file is 
initially searched in the directory where DynaN 3.0 was installed. Standard Windows-navigation 
procedures may be used to locate the name and directory of the desired project file. 
 

 
Figure 3.1   Window screen for the File – Open dialog  

 

 Every analytical run of DynaN 3.0 produces several additional files (as described in Table 2.1 of 
this manual).  The name of the input-data file indicates the names of all related files produced by a 
successful execution (output, graphics, and processor-text files). All the additional program files will be 
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created in the same directory as the input file. Input-data files that are partially completed may be saved 
and opened later for completion, run, and view of results.  
 Opening some partially-completed DynaN 3.0 input files or invalid data files may produce an 
information window reporting that an “invalid or incomplete” file is being opened (see Fig. 3.2). The 
user should click “OK,” and all partial-input data that was previously prepared should become available.  
 

 
Figure 3.2   Message window for incomplete or invalid files  

 

3.1.3 File -Save  

 This option is used to save input data under the current file name. With this method of storing 
data to disk, any input data that was previously saved with the same file name is replaced with the 
current parameters. Input-data files should be saved every time before proceeding with runs for 
analytical computation.  

3.1.4 File - Save As  

 This option allows the user to save any opened or new input-data file under a different file name 
or directory.  Any input-data file saved under an existing file name will replace the contents of the 
existing file.  

3.1.5 File - Exit  

 This is selected to exit DynaN 3.0. If any input-data file that was modified is not yet saved to disk 
while the option is selected, a confirmation window will appear before the program closes (see Fig. 3.3).  
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Figure 3.3   Message window advising that changes were not saved to disk  

 

3.2 Data Menu 
 The input of specific parameters for an application is controlled under options contained within 
this menu (shown in Fig. 3.4). It is recommended that the user choose each enabled submenu and enter 
parameters in a consecutive manner starting from the top option. Selecting or clicking any of the 
submenu choices contained in the Data menu produces various types of windows. 
 
As a reminder for standard commands of Microsoft Windows®, open windows may be closed by all or 
some of the following methods:  

• clicking the OK button (if available), or  
• clicking the X box on the upper-right corner of the window, or  
• double-clicking the DynaN 3.0 icon on the upper-left corner of the window, or  
• clicking once on the DynaN 3.0 icon on the upper-left corner of the window and then choosing 

“Close.”  
 
 Open windows may be left open on the screen by option. The selection of other menu options 
will then produce new windows on top of those that are left open.  
 Many sub-windows of the Data menu will show an Add Row, Insert Row and/or Delete Row 
buttons. The Add Row button always adds new rows at the end of all existing rows. The Insert Row 
button always insert a new row right after an existing row highlighted by the mouse. Clicking on the 
Delete Row button deletes the row where the cursor is located.  
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Figure 3.4   Options contained in the Data menu  

 

3.2.1 Numeric Data Entries  

 In addition to simple numeric entries, cells that require numeric data may also accept entries of 
mathematical expressions. Entering a mathematical expression works similarly to entering normal 
numeric data. The user types the expressions that represent the data and presses the “e” key to 
calculate the entered expression and to display the numeric result in the same cell.  
 Table 3.1 shows the list of supported operations and constants. The order of operations follows 
the order in the list of Table 3.1. Note that implicit multiplication (i.e. 2(4+6)) is not supported (instead, 
use 2*(4+6) for the previous example).  
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Table 3.1  Supported mathematical operations and constants  

 OPERATORS  
Symbol  Description  

()  Parenthesis (may be nested)  
^  Exponentiation  
*  Multiplication  
/  Division  
+  Addition  
- Subtraction  
- Negation (same as subtraction)  
  
 CONSTANTS  

Symbol  Value  
PI (or pi)  3.1415927  
e (or E)  2.7182818  

 
 
 The two constants that are currently supported are PI and e. Implicit multiplications using 
constants are not supported (use 2*e instead of 2e). Negation of the constants PI or e is not allowed.  
For instance, instead of entering -PI the user must enter -(PI).  
 Scientific notation (i.e., 1.65e8 or 1.65e-8) may be used to input very large or very small 
numbers. After an expression is calculated, very large or very small numbers will be displayed using 
scientific notation.  

3.2.2 Data -Title  

 This option activates the window shown in Fig. 3.5, where the user can enter a line of text 
containing a general description for the application problem. Any combination of characters may be 
entered into the text box in order to describe a particular application. The user input will be restrained 
automatically once the maximum length of text is reached. This is done to prevent the user from going 
beyond the maximum permissible length of characters allowed for the title line.  
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Figure 3.5   Window screen for sample Data - Title  

 

3.2.3 Data - Units 
This option provides the user with a choice of specifying input data in English Units, and S. I. 

Units (International UnitsSystem). In general, the following specific units of measurements will be used 
throughout the program: 
 

Units Length Force Mass 
English ft lbs Slug 

International m kiloNewtons (kN) Mg 
 
 The user should always check the unit specification, which is affixed to each variable, for data 
input. For instance, psf or kPa are issued for the elastic modulus of materials. 
 The user may change from one system of units to the other as many times as desired. The 
program will automatically convert all the appropriate inputs that were already specified by the user 
before the time of selection of a different system of units. Small conversion errors may appear if 
multiple changes of units are performed. The user must always check that input data have been 
converted appropriately. 

3.2.4 Data - Option of Foundation System 
 This submenu option allows the user to select one of four available foundation types, i.e. half-
space, stratum, multi-layer, and pile. A sub-window appears on the screen when the option is clicked 
(Fig. 3.6). The user can simply pull down the list box on the windows screen and make the selection. For 
each selection, an illustration of this type of foundation system will be shown on the screen. The sketch 
on the screen can help the user to understand the characteristic of each foundation system. 
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Figure 3.6   Window screen for sample Data – Footing type  

 

3.2.5 Data - Option of Loading 
 This submenu option allows the user to select one of three available loading types, i.e. harmonic 
loading, transient loading, and random loading. A sub-menu appears on the screen when the option is 
clicked (Fig. 3.7). The user can simply use the mouse to click on the intended loading type. In 
correspondance to the user’s selection, an menu item provided for entering the specific loading data will 
be enabled in the lower portion of the Data Menu as shown in Fig. 3.7, which will be described later. 
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Figure 3.7   Window screen for sample Data – Option of Loading  

 

3.2.6 Data - Option of Foundation Shape 
 This submenu option allows the user to select a circular foundation or a rectangular foundation. 
A sub-window appears on the screen when the option is clicked (Fig. 3.8). The user can simply click one 
of radio buttons for the intended foundation shape. The user needs to enter the radius of the 
foundation in correspondance to the circular shape and then enter the length and width in 
correspondance to the rectangular shape. 
 

                                                     COPYRIGHT © ENSOFT, INC 2012 
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTHORIZATION FROM ENSOFT, INC



  CHAPTER 3    Data Input      3-10 
 

Dyna-N 3.0 for Windows User's Manual 
 

 

Figure 3.8   Window screen for sample Data – Option of Foundation Shape  

 

3.2.7 Data - Footing Mass Parameters 
This submenu option allows the user to input the mass moment of inertia, total mass, and cross-

product of inertia. A sub-window appears on the screen when the option is clicked (Fig. 3.9). The 
following parameters are needed for the completion of data entry: 
 

o Total mass of footing 
o Mass moment of inertia about x-axis 
o Mass moment of inertia about y-axis 
o Mass moment of inertia about z-axis 
o Mass cross product x-y (product of inertia) 
o Mass cross product x-z (product of inertia) 
o Mass cross product y-z (product of inertia) 

 
If the data of mass moments of inertia have been figured out, the user should directly enter those data 
into the entry field as shown at the right side of Figure 3.9. If the user does not have a tool to calculate 
the center of gravity of the whole foundation system and the associated mass moment of inertia, the 
program provides a tool for making those computations. 
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Figure 3.9   Window screen for sample Data – Option of Mass Parameters  

 
Mass moment of inertia should include all equipment loads and selfweightof the concrete footing or 
cap. If you need the program to help you make computations, please click the Button “Input all the mass 
components” located on the bottomleft corner of the window screen for Footing Mass parameters as 
shown on Figure 3.9. After all the data is entered, you may click the next Button “Calculate mass 
moment of inertia”. The data editing box at the right side will be filled with computed data. 
 
The example shown on Figure 3.10 and Figure 3.11 is provided for the user to better understand how to 
use Dyna-N v3.0 to compute the mass moment of inertia of a footing or cap. The system 
characterization consists of 2 lumped masses (motor and pump) and 3 rectangular concrete blocks. 
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Figure 3.10  Illustration example for computation of mass parameters  

 

 

Figure 3.11  Physical dimensions of the illustrated example 
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The parameter for the lumped masses are: 
 

No. Mass X-Coord. Y-Coord. Z-Coord. 
1 0.180E+05 0.289E+01 0.390E+01 0.399E+01 
2 0.290E+05 0.746E+01 0.390E+01 0.399E+01 

 
The parameters for the rectangular concrete blocks are: 
 

No. Mass X-Length Y-Length Z-Length 
1 252720 0.108E+02 0.780E+01 0.120E+01 
2 62677 0.487E+01 0.260E+01 0.198E+01 
3 8112 0.800E+00 0.260E+01 0.156E+01 

 
Center of Masses 

 
No. X-Coord. Y-Coord. Z-Coord. 

1 0.540E+01 0.390E+01 0.600E+00 
2 0.348E+01 0.390E+01 0.219E+01 
3 0.936E+01 0.390E+01 0.198E+01 

 
The dimension s (Length, Width, and Thickness) for the lumped masses are significantly smaller 
than those of the rectangular concrete blocks, so these values can be neglected on this example. 
You can see all the input parameters in Figure 3.12. After all the data is entered, just click the 
Button “Calculate mass moment of inertia” and the program will compute the values for you. 
The data editing box at the right side of the Footing Mass Parameter window will be filled out 
wit the computed data. 
 
The results for this example are provided below for comparison purposes. 
 
Total Mass = 0.3705E+06 
Mass Moment of Inertia: 
I(XX) = 0.1889E+07 
I(YY) = 0.3729E+07 
I(ZZ) = 0.4482E+07 
I(XY) = 0.0000E+00 
I(XZ) = 0.4409E+05 
I(YZ) = 0.0000E+00 
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Figure 3.12  Window screen for sample Data –Internally-Calculated Mass Parameters 

 

3.2.8 Data - Foundation Dimen. and Constants 
 This submenu option allows the user to input the foundation dimensions related to the center 
of gravity. A sub-window appears on the screen when the option is clicked (Fig. 3.13). The following 
parameters are needed for the completion of data entry: 
 

o Distance from center of foundation base to center of gravity (Xc) 
 

o Distance from center of foundation base to center of gravity (Yc) 
 

o Height of center of gravity (Zc) 
 
The following two items are only required for Stratum foundations 
 

o Depth from ground surface to base of foundation (Df) 
 

o Depth from ground surface to bed rock (rigid underlying layer) (Dr) 
 
Extra items are also needed for Multilayer Foundation, which can be reviewed in the example - 
EXP61.dyd. 
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Figure 3.13  Window screen for sample Data – Option of Foundation Dimension and Constant 

 

3.2.9 Data - Foundation Layer Data (Multilayer Fondation) 
 This submenu allows the user to enter the foundation layers and geometric properties for a 
multi-layer type of foundation. An illustration of the Foundation Layer Data window for an example 
application is shown in Fig. 3.14. 
 
 The following parameters are needed for the completion of data entry: 

• Layer number: The user may divide the foundation into several layers (increments) based on 
the variation of dimension versus the embedment. This is a sequential number that is 
provided to each foundation layer. This number is automatically provided by the program as 
new rows of foundation layers are added. The maximum number of foundation layers that 
may be used in a program is limited to 20. 

• Layer thickness: The Layer thickness option allows the user to define the thickness of each 
layer. The English unit for this variable is “ft”, while “meter” is used for SI unit notations. 

• Radius of foundation (X): This is the radius of foundation along the x-direction. 
• Radius of foundation (Y): This is the radius of foundation along the y-direction. 
• Cross-sectional area: This is the area of foundation. 
• Cross-sectional moment of inertia (X-direction): This is the moment of inertia of the 

foundation along the x-direction. 
• Cross-sectional moment of inertia (Y-direction): This is the moment of inertia of the 

foundation along the y-direction. 
• Cross-sectional torsion coefficient: This is the moment of inertia of the torsional resistance. 
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Figure 3.14  Window screen for sample Data – Option of Foundation Layer 

 

3.2.10 Data - Pile Cap Shape/Dimension 
 This submenu option allows the user to select a circular pile cap or a rectangular pile cap. A sub-
window appears on the screen when the option is selected (Fig. 3.15). The user can simply click one of 
radio buttons to indicate the intended the shape. The user needs to enter the radius of the foundation 
in correspondance to the circular shape and the length and width in correspondance to the rectangular 
shape. Mass parameters for the pile cap are similar to Section 3.2.7. 
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Figure 3.15  Window screen for sample Data – Option of Pile Cap Shape/Dimension 

 

3.2.11 Data - Pile Cap Mass Properties 
 Mass parameters for the pile cap are similar to Section 3.2.7. 

3.2.12 Data - Pile Coordinates 
 The origin for the coordinate system is set up at the geometric center of the top of the pile cap. 
This option allows the user to define the coordinates of the pile heads and the battered angles of each 
pile. A sub-window (Fig. 3.16) appears on the screen when the option is clicked. The following sections 
will provide general description on data needed for each entry: 

• Pile number: This is a sequential number that is provided to identify each pile. This number is 
automatically provided by the program as new rows of piles are added. The maximum number 
of piles that may be used in a program run is 200. 

• Xc: In this entry, the user may specify the x-coordinate of the pile head measured from the 
origin. The English unit for this variable is the inch, while meters are used for SI notation. 

• Yc: In this entry, the user may specify the x-coordinate of the pile head measured from the 
origin. The English unit for this variable is the inch, while meters are used for SI notation. 

• Batter Plane: When a pile is driven at an angle to the vertical (Z-direction), the pile may be 
battered on the XZ-plane or the YZ-plane. The user can make a selection by pulling down the list 
items in the cell. 

• Battered Angle: The battered angle is specified as the deviation in degrees from the vertical (z-
axis). 
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Figure 3.16  Window screen for sample Data – Option of Pile Coordinates 

 

3.2.13 Data - Pile Properties 
This option allows the user to define the material properties, the pile-cap dimension related to the 

center of gravity, the pile length, and other pile-related data. A sub-window (Fig. 3.17) appears on the 
screen when the option is clicked. The following parameters are needed for the completion of data 
entry. 

• Xc: Distance from center of foundation base to center of gravity in X direction. The English unit 
for this variable is the inch, while meters are used for SI notation. 

• Yc: Distance from center of foundation base to center of gravity in Y direction. The English unit 
for this variable is the inch, while meters are used for SI notation. 

• Zc: Height of center of gravity. 
• PW: In this entry the user may specify the unit weight of the pile. The English notation for this 

variable is lb/ cubic inch, while the SI notation is kN/cubic meter. 

• PL: Total length of pile. The English unit for this variable is the inch, while meters are used for SI 
notation. 

• Poission’s Ratio: In this entry the user may specify the Poission’s ratio for a given pile. 

• Material Damping: In this entry the user may specify the damping ratio for a given pile. 

• Cross-sectional Coefficient of Rigidity for Shear Effect: The data can be used to consider the 
effect of shear. Typically use 1.334 for solid circular sections, and 1.52 for rectangular sections. 

• SLD: In this entry the user may specify the static load on each pile. The English notation for this 
variable is lbs, while the SI notation is kN. 
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• Connection on the Pile head: In this entry the user may specify either pinned or fixed 
connection between the pile head and the pile cap. 

• Method of Pile Support: In this entry the user may specify that piles behave as either end 
bearing piles or floating piles. 

• Consider the interaction of pile-soil-pile: In this entry the user may specify pile-soil-pile 
interaction to be considered in the analysis. 
 

 

Figure 3.17  Window screen for sample Data – Option of Pile Properties 

3.2.14 Data - Pile Elements 
 This option allows the user to define the radius, the moment of inertia, the layer increments, 
and the torsional coefficient. A sub-window (Fig. 3.18) appears on the screen when the option is clicked. 
The following sections will provide general descriptions on data needed for each entry. 

• Layer number: The user may divides the pile into several layers (increments) based on the 
variation of dimension versus the penetration. This is a sequential number that is provided for 
each pile layer (increment). This number is automatically provided by the program as new rows 
of pile layers are added. The maximum number of pile layers that may be used in a program is 
30. 

• Layer thickness: The Layer thickness option allows the user to define the thickness of each layer. 
The English notation for this variable is “in” (inch), while the SI notation is “m” (meter). 

• Radius of Pile (X): This is the radius of the pile along the x-direction. 
• Radius of Pile (Y): This is the radius of the pile along the y-direction. 
• Cross-sectional area: This is the area of the pile cross-section at that particular layer. 
• Cross-sectional moment of inertia (X-direction): This is the moment of inertia of the pile along 

the x-direction. 
• Cross-sectional moment of inertia (Y-direction): This is the moment of inertia of the pile along 

the y-direction. 
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• Cross-sectional torsion coefficient. 
 

 

Figure 3.18  Window screen for sample Data – Option of Pile Elements 

 

3.2.15 Data - Soil Layer Data 
 This option allows the user to input the properties of soils that are next to the side of the 
foundation. The parameters of the weak zone in the side soil can be specified. A sub-window (Fig. 
3.19) appears on the screen when the option is clicked. The following sections will provide general 
description on data needed for each entry. 

• Layer number: The user may divide the soil into several layers (increments) based on the 
variation of soils. This is a sequential number that is provided for each soil layer (increment). 
This number is automatically provided by the program as new rows of soil layers are added. The 
maximum number of soil layers that may be used in a program is 30. The arrangement of soil 
layers should be consistent with the foundation layers or pile layers mentioned earlier. 

• Layer thickness (not required in this version): The Layer thickness option allows the user to 
define the thickness for each layer. The thickness of soil layers should be consistent with the 
foundation layers or pile layers mentioned earlier. The English notation for this variable is inch, 
while the SI notation is meter. 

• Shear Wave Velocity: In this entry the user may specify the shear wave velocity for a given 
layer. The English notation for this variable ft/sec, while the SI notation is meter/sec. 

• Unit Weight: In this entry the user may specify the unit weight for a given layer. The English unit 
for this variable is “lb/cu. ft”, while “kN/cu. m” is for the SI unit. 

• Poisson’s ratio: In this entry the user may specify the Poisson’s ratio for a given stratum. The 
Poisson’s ratio typically is between 0.35 to 0.5 for soils. Poisson’s ratio near 0.5 is recommended 
for liquefied soils. 

• Material Damping: In this entry the user may specify the material damping for each soil layer. 
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• Weak Shear Modulus Ratio: In this entry the user may specify the reduction ratio for the shear 
modulus of soils next to the side of the foundation. The weakened zone input was reduced to 
use only one parameter (shear modulus ratio) in this latest version. If the user enters 1.0 for the 
ratio of shear modulus (Gi/Go) in the weakened zone, it represents no weakened zone. If the 
user enter any value between 0.0 and 1.0 for the shear modulus ratio, the program will assume 
a weakened zone existed. For machine vibration, shear modulus ratio (Gi/Go) = 0.25 - 0.5 is 
commonly used. For seismic applications, strong vibration may reduced the shear modulus ratio 
(Gi/Go) to be less than 0.25. The damping ratio in the weakened zone will be twice of the 
original damping ratio and the thickness of the weak zone will be one pile radius if the shear 
modulus ratio is less than 1.0. 

 

Figure 3.19  Window screen for sample Data – Option of Side Soil of Foundation 

 

3.2.16 Data - Soil Data Below Footing/Pile Tip 
This option allows the user to input the properties of the soil that are below the footing or pile tip. A 

sub-window (Fig. 3.20) appears on the screen when the option is clicked. The following sections will 
provide general descriptions for data needed for each entry. 
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Figure 3.20  Window screen for sample Data – Option of Soil Data below Fo0ting/Pile Tip 

 

• Shear Wave Velocity: In this entry the user may specify the shear wave velocity for the soil 
below the footing or pile tip. The English notation for this variable is ft/sec, while the SI notation 
is meter/sec. 

• Unit Weight: In this entry the user may specify the unit weight for the soil below the footing or 
pile tip. The English notation for this variable is lb/cu.ft., while the SI notation is kN/cu. m. 

• Poisson’s ratio: In this entry the user may specify the Poisson’s ratio for the soil below the 
footing or pile tip. The Poisson’s ratio typically is between 0.35 to 0.5 for soils. Poisson’s ratio 
near 0.5 is recommended for liquefied soils. Poisson’s ratio near 0.5 is recommended for liquefied 
soils. 

• Material Damping: In this entry the user may specify the material damping for the soil below 
the footing or pile tip. 

3.2.17 Data - Side Soils Next to Pile Cap 
 This option allows the user to input the properties of the soil that are next to the pile cap. The 
parameters of weak zone in the side soil can be specified. A sub-window (Fig. 3.21) appears on the 
screen when the option is clicked. The following sections will provide general descriptions on data 
needed for each entry. 

• Layer number: The user may divide the soil into several layers (increments) based on the 
variation of soils. This is a sequential number that is provided for each soil layer (increment). 
This number is automatically provided by the program as new rows of soil layers are added. The 
maximum number of soil layers that may be used in a program is 30. The arrangement of soil 
layers should be consistent with the foundation layers or pile layers mentioned earlier. 

• Layer thickness: The Layer thickness option allows the user to define the thickness for each 
layer. The thickness of soil layers should be consistent with the foundation layers or pile layers 
mentioned earlier. The English notation for this variable is in inches, while the SI notation is in 
meters. 
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• Shear Wave Velocity: In this entry the user may specify the shear wave velocity for a given 
layer. The English notation for this variable is in ft/sec, while the SI notation is in meter/sec. 

• Unit Weight:In this entry the user may specify the unit weight for a given layer. The English 
notation for this variable is in lb/cu. ft., while the SI notation is in kN/cu. m. 

• Poisson’s ratio: In this entry the user may specify the Poisson’s ratio for a given stratum. The 
Poisson’s ratio typically is between 0.35 to 0.5 for soils. 

• Material Damping: In this entry the user may specify the material damping for each soil layer. 
• Weak Shear Modulus Ratio: In this entry the user may specify the reduction ratio for the shear 

modulus of soils next to the side of the foundation. The weakened zone input was reduced to 
use only one parameter (shear modulus ratio) in this latest version. If the user enters 1.0 for the 
ratio of shear modulus (Gi/Go) in the weakened zone, it represents no weakened zone. If the 
user enter any value between 0.0 and 1.0 for the shear modulus ratio, the program will assume 
a weakened zone existed. For machine vibration, shear modulus ratio (Gi/Go) = 0.25 - 0.5 is 
commonly used. For seismic applications, strong vibration may reduced the shear modulus ratio 
(Gi/Go) to be less than 0.25. The damping ratio in the weakened zone will be twice of the 
original damping ratio and the thickness of the weak zone will be one pile radius if the shear 
modulus ratio is less than 1.0. 

 

Figure 3.21  Window screen for sample Data – Option of Side Soil Next to Pile Cap 

 

3.2.18 Data - Soil Column Layer 
 This option allows the user to to input the properties of the soil layers that are below the multi-
layer type of foundation. A sub-window (Fig. 3.22) appears on the screen when the option is clicked. The 
following sections will provide general descriptions on data needed for each entry. 

• Layer number: The user may divides the soil into several layers (increments) based on the 
variation of soils. This is a sequential number that is provided for each soil layer (increment). 
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This number is automatically provided by the program as new rows of soil layers are added. The 
maximum number of soil layers that may be used in a program is 30. The arrangement of soil 
layers should be consistent with the foundation layers or pile layers mentioned earlier. 

• Shear Wave Velocity: In this entry the user may specify the shear wave velocity for a given 
layer. The English notation for this variable is in ft/sec, while the SI notation is in meter/sec. 

• Unit Weight: In this entry the user may specify the unit weight for a given layer. The English 
notation for this variable is in lb/cu. ft., while the SI notation is in kN/cu. m. 

• Poisson’s ratio: In this entry the user may specify the Poisson’s ratio for a given stratum. The 
Poisson’s ratio is typically between 0.35 to 0.5 for soils. Poisson’s ratio near 0.5 is recommended 
for liquefied soils. 

• Material Damping: In this entry the user may specify the material damping for a given stratum. 
There are several different definitions for the term of damping coefficient in technical literature. 
The material damping defined in this program is directly related to the energy loss, and the 
typical coefficient of damping can be found in technical section (Chapter 5). 

• Weak Shear Modulus Ratio: In this entry the user may specify the reduction ratio for the shear 
modulus of soils next to the side of the foundation. The weakened zone input was reduced to 
use only one parameter (shear modulus ratio) in this latest version. If the user enters 1.0 for the 
ratio of shear modulus (Gi/Go) in the weakened zone, it represents no weakened zone. If the 
user enter any value between 0.0 and 1.0 for the shear modulus ratio, the program will assume 
a weakened zone existed. For machine vibration, shear modulus ratio (Gi/Go) = 0.25 - 0.5 is 
commonly used. For seismic applications, strong vibration may reduced the shear modulus ratio 
(Gi/Go) to be less than 0.25. The damping ratio in the weakened zone will be twice of the 
original damping ratio and the thickness of the weak zone will be one pile radius if the shear 
modulus ratio is less than 1.0. 
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Figure 3.22  Window screen for sample Data – Option of Soil Column Layer 

 

3.2.19 Data - Harmonic Loading Data 
 This option allows the user to to input data for harmonic loading. A sub-window (Fig. 3.23) 
appears on the screen when the option is clicked. The user can select Quadratic load, which varies with 
frequency, or Nonquadratic load, which is a constant load. The following parameters are required for 
the completion of the data entry: 

o Maximum frequency 
o Minimum frequency 
o Step frequency 
o Force in x-direction 
o Force in y-direction 
o Force in z-direction 
o Moment about x-axis 
o Moment about y-axis 
o Moment about z-axis 

The unit for the frequency input is in Hz and some output data may use rad/sec for the unit. 
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Figure 3.23  Window screen for sample Data – Option of Harmonic Loading  

 

3.2.20 Data - Transient Loading Data 
 This option allows the user to input data for transient loading. A sub-window (Fig. 3.24) appears 
on the screen when the option is clicked. The following sections will provide general descriptions on 
data needed for each entry: 
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Figure 3.24  Window screen for sample Data – Option of Transient Loading  

• Number of Points: In this entry the user may specify the total number of data points to be used 
for defining the load. 

• Time Interval Between Points: In this entry the user may specify the time interval between the 
loading points. It should be noted that the time interval is the same between the points. 

• Enter the Load Type and Load Amplitude: The user can simply click the Data Button to display a 
sub-window on the screen as shown in Fig. 3.24. 

 For all windows within this submenu, the Add Row button always adds new rows at the end of 
all existing rows. Clicking on the Delete Row button deletes the row where the cursor is currently 
located. 

 A general description for the data needed under each column for the submenu option -
Transient Loading Data is listed below: 

• Set: This is a sequential number that is provided for each set of loading curves. This number is 
automatically provided by the program as new sets of transient load curves are added. The 
maximum number of sets of transient load curves that may be used in the analysis is 6. 

• Load Types: In this entry the user may specify a loading type by pulling down the list box shown 
in the cell. The list box contains a total of 6 choices, i.e. force in x-direction, force in y-direction, 
force in z-direction, moment about x-axis, moment about y-axis, and moment about z-axis. 

• Load Amplitude: Clicking of this button provides an additional window where the user inputs 
the points for each set of transient load curves. An illustration of the specific input information 
for transient load curve 1 is shown in Fig. 3.24. Options contained within the windows for 
Transient Loading Data are the following: 
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• Point: this is a sequential number that is provided for each point of the transient load curve 
being defined. This number is automatically provided by the program as new rows are added. 
The maximum number of points that may be used in each curve is 2000. 

• Load: input the magnitude of the transient load at each point. 

3.2.21 Data - Random Loading Data 
 This option allows the user to input data for random loading. A subwindow (Fig. 3.25) appears 
on the screen when the option is clicked. 

The following sections will provide general description on data needed for each entry: 

• Maximum Frequency: In this entry the user may specify the maximum frequency for the 
random load. 

• Minimum Frequency: In this entry the user may specify the minimum frequency for the random 
load. 

• Number of Points to Be Read: In this entry the user may specify the total number of points to 
be read for each loading set. 

• Observation Period: In this entry the user may specify the observation set. 
• Number of Spectrum: In this entry the user may specify the number of spectrum. 
• Enter Spectrum Coordinates and Spectrum Amplitude: The user can simply click the Data 

Button to display a sub-window on the screen as shown in Fig. 3.25. 

 For all windows within this submenu, the Add Row button always adds new rows at the end, 
after all existing rows. Clicking on the Delete Row button deletes the row where the cursor is currently 
located. 
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Figure 3.25  Window screen for sample Data – Option of Random Loading  

 

 A general description for the data needed under each column for the submenu option -Random 
Loading Data is listed below: 

• Set: This is a sequential number that is provided for each set of loading curves. This number is 
automatically provided by the program as new sets of transient load curves are added. The 
maximum number of sets of transient load curves that may be used in the analysis is 6. 

• Spectrum Coordinates: In this entry the user may specify the spectrum coordinates by pulling 
down the list box shown in the cell. The list box contains a total of 6 choices, i.e. force in x-
direction, force in y-direction, force in z-direction, moment about x-axis, moment about y-axis, 
and moment about z-axis. 

• Load Amplitude: Clicking of this button provides an additional window where the user inputs 
the points for each set of random load curves. An illustration of the specific input information 
for random load curve 1 is shown in Fig. 3.25. Options contained within the windows for 
Random Loading Data are the following: 

• Point: this is a sequential number that is provided for each point of the transient load curve 
being defined. This number is automatically provided by the program as new rows are added. 
The maximum number of points that may be used in each curve is 2000. 

• Spectrum Ordinates: values of spectrum ordinates. 
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3.2.22 Data - Control Options... 
 The user should input in this box the complete path and command line for the preferred-text 
editor or word processor that will be used to examine and print the input, output, and the processor, 
plain-text files created by the program (Fig. 3.26). As a default, the command line 
c:\windows\notepad.exe is used to operate the standard-text editor. Microsoft Notepad is included with 
Windows 2000, Vista, XP or 7. However, there may be some instances when the output files are too 
large for Notepad and a different text editor or word processor should be used. In those cases it is 
suggested that one use Microsoft WordPad (c:\windows\write.exe) 

 

Figure 3.26  Window screen for sample Data – Control Option  
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4.1 Introduction  
 Chapter 4 presents options related to execution of the program and includes methods of 
addressing run-time errors. This chapter also includes suggestions for reviewing input, output, and 
processor text files. The final section of this chapter includes descriptions about all the output curves 
that may be observed in graphical form. The commands covered in this chapter are contained in the top 
menu, under the Computation and the Graphics titles. 
 

4.2 Computation Menu 
 This menu option is selected to execute the program using the parameters that were saved in 
the input-data file. Within the options contained under this menu, shown in Fig. 4.1, there are 
commands that facilitate the reviews of the text files produced for storing input data, output results, 
and processor notes. Detailed descriptions of the submenu options contained under the Computation 
menu are explained in the following topics. 
 

 
Figure 4.1  Command options contained in the Computation menu 

 

4.3 Computation - Run Analysis 
 An input file, after preparation or modification, must be saved to disk before selecting the 
Computation - Run Analysis submenu option, which executes the analytical portion of program DYNAN 
3.0. The module, a stand-alone program routine, is called for execution by the “shell” process of the 
environment in Microsoft Windows©. 
 The user should remember to save the input data under an user-specified name before 
executing the analytical module. When saving data to disk, DYNAN 3.0 will automatically add an 
extension of the type *.dnd to the name of the input file. 
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 A sub-window is usually produced during the execution of the module. When the module’s 
execution process is finished, the sub-window automatically disappears, and the active command is 
returned to the main DYNAN 3.0 program.  
 At the beginning of the run, the analytical module will read the saved input data progressively, 
showing the line number being read. If an input-data format is incorrect during reading, the analytical 
module will stop immediately, and, in many cases, it saves an error message and a status report in a file 
with the extension *.dnr. This file may be accessed by selecting Edit Processor-Run Notes in the 
Computation menu. 
 Within the processor-run notes, if all input data was read correctly, the analytical module will 
show the message THE EXECUTION IS IN PROGRESS....... The analytical module automatically creates an 
output file with the same name as the input and with the extension *.dno. Once a successful run is 
produced, the user may proceed to the next items for observation of results. 

4.3.1 Computation - Edit Input Text 
 This submenu option is used to edit the input-data file in plaintext mode. This command 
becomes active after new data files have been saved to disk or when opening existing data files. The 
command is helpful for experienced users who may just want to change one or two parameters quickly 
using the text editor or for those users wishing to observe the prepared input data in text mode.  
 This submenu automatically invokes the word processor or text editor specified in Control 
Options... under the Data menu. The default setting is to use the utility program named notepad.exe 
provided by Microsoft Windows©. 
 Input-data files are automatically saved to disk with the extension of *.dnd by program DYNAN 
3.0. Use of the notepad for editing the input data for Example Problem 1 is shown in Fig. 4.2. 
 

 
Figure 4.2  Sample use of Microsoft Notepad for editing input text file 
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4.3.2 Computation - Edit Processor Run Notes 
 This submenu option is used to edit an intermediate text file that is automatically produced 
during each analytical run. This file only includes notes produced during the processing of the input data. 
This submenu option becomes active after new-data files have been saved to disk and executed, or 
when opening previously-executed data files. 
 This submenu automatically invokes the word processor or text editor specified in Control 
Options, under the Data menu. The default setting is to use the utility program named notepad.exe 
provided by Microsoft Windows©. Files containing processor-run notes are automatically saved to disk 
with the same file name as the input-data file but with the extension *.dnr.  Observation of the notes 
produced during a processor run may become helpful when debugging a data file that did not produce a 
successful run. 

4.3.3 Computation - Edit Output Text 
 This submenu option is used to edit the output-text file that is automatically produced during 
each analytical run. This command becomes active after new data files have been saved to disk and 
successfully executed or when opening previously-executed data files. 
 The submenu automatically invokes the word processor or text editor that was previously 
specified in Control Options, under the Data menu. The default setting is to use the utility program 
named notepad.exe provided by Microsoft Windows©. 
 Output files are automatically saved to disk with the same file name as the input-data file but 
with the extension *.dno. Use of Microsoft Notepad© for editing the output file for Example Problem 1 
is shown in Fig. 4.3. 
 

 
Figure 4.3  Sample use of Microsoft Notepad for editing output text file 
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4.4 Graphics Menu 
 This menu option is selected to observe the different graphical representations of the program 
results contained in the output file. Submenu options contained under this menu are shown in Fig. 4.4. 
Not all of the graphics may be enabled for observation; active curves depend on specifications contained 
in the input. 
 All of the graphical representation of output data that may be produced by the program are 
contained in the following commands of the Graphics menu: 

• Translation Stiffness (Kxx, Kyy, Kww)…: this option providesa plot of translation stiffness of 
foundations vs. loading frequencies. 

• Rotational Stiffness (Kppx, Kppy, Kzt)…: this option provides a plot of rotational stiffness of 
foundations vs. loading frequencies. 

• Translation Damping (Cxx, Cyy, Cww)…: this option provides a plot of translation damping of 
foundations vs. loading frequencies. 

• Rotational Damping (Cppx, Cppy, Czt) …: this option provides a plot of rotational damping of 
foundations vs. loading frequencies. 

• Foundation Response Amplitude in Displacement…: this option provides a plot of response 
amplitude in displacement of foundations vs. loading frequencies. 

• Foundation Response Amplitude in Rotation…: this option provides a plot of response 
amplitude in rotation of foundations vs. loading frequencies. 
 

 The observation of any of the above-listed curves will activate the graphics mode of DYNAN 3.0. 
Several changes occur during use of the graphics mode, such as new mouse commands are enabled and 
a new top-menu option becomes available. 
 

 
Figure 4.4  Command option contained in the Graphics menu 

 

                                                     COPYRIGHT © ENSOFT, INC 2012 
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTHORIZATION FROM ENSOFT, INC



  CHAPTER 4    Program Execution and Output Reviews    4-6 
 

Dyna-N 3.0 for Windows User's Manual 
 

4.4.1 Mouse Commands in the Graphics Mode 
 Table 4.1 describes mouse commands that become enabled automatically during all graphical 
observations of output curves. 
 

Table 4.1  Mouse commands in the graphics mode 

 
Event Description 

Mouse Left Click Zooms in on the graphics at the clicked 
position  (up to five zoom levels) 

Mouse Right Click Zooms out from the graphics 
Mouse Double Click on 
Legend 

Turns the selected curve on/off at every click 

 
 

4.4.2 Plot Menu 
 This new menu command only appears in the top-menu bar during graphics mode. Command 
options contained in this menu, shown in Fig. 4.5, are explained below. 
 

 
Figure 4.5  Command option contained in the Plot menu 

 
 

• Show Legend: This activates or deactivates the floating legend included in the graphics mode. 
The legend box can be moved with click-and-drag operations of the mouse to any position in the 
graphics screen. Despite its location in the screen, the legend is always located at the right-
bottom corner of the printouts. 

                                                     COPYRIGHT © ENSOFT, INC 2012 
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTHORIZATION FROM ENSOFT, INC



  CHAPTER 4    Program Execution and Output Reviews    4-7 
 

Dyna-N 3.0 for Windows User's Manual 
 

• Show Markers: This menu provides the option to activate or deactivate the markers for each 
point of all the curves displayed in the active screen of the graphics mode. The user may 
optionally select to show markers every 1, 2, 3, 5, or 10 increments of unit. The type of markers 
used in each curve is automatically selected by the program. Once activated, the markers are 
enabled for all visible curves of the active graphics screen. 

• Print...:This command is used to produce a hard copy of the active graphics screen. The Print 
sub-windows includes a drop-down menu that allows the user to select any of the installed 
Windows printers, allows for change of printer properties, and allows the selection of the total 
number of copies to be printed. The printed graphics is sized according to the margins that the 
user specifies in the Plot - Page Setup menu. 

• Page Setup: The user can here specify the printed size of the active-graphics screen. The size of 
the plot is base on the specified margins and selection of paper orientation. The parameters 
selected here are not saved with the output file and must be changed each time that the 
graphics is plotted. 

• Save to Disk...: This command is used to save the active-graphics screen to disk. The format of 
the saved file is as bmp graphics (bitmap file), which is the internal-file format used in Microsoft 
Windows©. Graph Title: The user may add a title to the active graphics using this command. 
The parameters selected here are not saved with the output file and must be changed each time 
the file is opened. 

• Edit Legend: The user may change the text of the legend in the active graphics using this 
command. The modified names are not saved with the output file and must be changed each 
time the file is opened. 

4.4.3 Graphics - Translation Stiffness (Kxx, Kyy,Kww) 
 This option provides a plot of translation stiffness of foundations vs. loading frequencies. A 
sample graphics screen of the Translation Stiffness of Foundation command option is shown in Fig. 4.6. 
 

 
Figure 4.6  Translation stiffness command option for Example 1 
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4.4.4 Graphics - Rotational Stiffness (Kxx, Kyy,Kww) 
 This option provides a plot of rotational stiffness of foundations vs. loading frequencies. A 
sample graphics screen of the Rotational Stiffness of Foundation command option is shown in Fig. 4.7. 
 

 
Figure 4.7  TranslationRotational stiffness command option for Example 1 

 

4.4.5 Graphics - Translation Damping (Cxx, Cyy, Cww) 
 This option provides a plot of translation damping of foundations vs. loading frequencies. A 
sample graphics screen of the Translation Damping of Foundation command option is shown in Fig. 4.8. 
 
 

                                                     COPYRIGHT © ENSOFT, INC 2012 
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTHORIZATION FROM ENSOFT, INC



  CHAPTER 4    Program Execution and Output Reviews    4-9 
 

Dyna-N 3.0 for Windows User's Manual 
 

 
 

Figure 4.8  Translation damping command option for Example 1 

 

4.4.6 Graphics - Rotational Damping (Cpxx, Cpyy, Crt) 
 This option provides a plot of rotational damping of foundations vs. loading frequencies. A 
sample graphics screen of the Rotational Damping of Foundation command option is shown in Fig. 4.9. 
 

 
Figure 4.9  Rotational damping command option for Example 1 
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4.4.7 Graphics - Foundation Response Amplitude in Displacement 
 The user may select this command option to observe a graphical representation of the 
foundation response amplitude in displacement vs. loading frequencies at c.g. for the modeled 
foundation. This curve is automatically generated in all analytical runs of a foundation. A sample 
graphics screen of the Foundation Response Amplitude in Displacement command option is shown in 
Fig. 4.10. 

 
Figure 4.10  Foundation response amplitude in displacement command option for Example 1 

 

4.4.8 Graphics - Foundation Response Amplitude in Rotation 
 The user may select this command option to observe a graphical representation of the 
foundation response amplitude in rotation vs. loading frequencies at c.g. for the modeled foundation. 
This curve is automatically generated in all analytical runs of a foundation. A sample graphics screen of 
the Foundation Response Amplitude in Rotation command option is shown in Fig. 4.11. 
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Figure 4.11  Foundation response amplitude in rotation command option for Example 1 

4.4.9 Graphics – Interactive Footing Response Amplitude  
 The user may select this command option to observe a graphical representation of the 
foundation response amplitude at locations different from the c.g. for the modeled foundation. The user 
can enter the coordinates of the reference point and the curves automatically reflect the results based 
on the new assigned reference point in on the foundation. A sample graphics screen of the Interactive 
Footing Response Amplitude command option is shown in Fig. 4.12. 
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Figure 4.12  Foundation response amplitude in rotation command option for Example 1 

 

4.5 View Geometry 
 The View menu is used to review, in proportional graphical form, the geometric shape and 
configuration for the modeled foundation. Submenu options are shown in Fig. 4.12 along with additional 
sub-window showing the side view of the foundation described in Example 1. The three submenu 
options are described below. 
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Figure 4.13  Command option contained in the View Geometry menu 

 

Top View: This option provides a plan view of the foundation model, as observed from the top. For the 
example shown in Fig. 4.13, the pile group from left-to-right are composed of three piles in each row.  
 

 
Figure 4.14  View Geometry menu – Top view 
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Side View (XZ-plane): This option provides a lateral view of the foundation model projected on XZ-plane 
as shown in Fig. 4.14. This drawing will include soil layers which are defined by the user. 
 

 
Figure 4.15  View Geometry menu – Side view (XZ plane) 

 

Side View (YZ-plane): This option provides a lateral view of the foundation model projected on YZ-plane 
as shown in Fig. 4.15. This drawing will include soil layers which are defined by the user. 
 
3D View: This option provides a three-dimensional view of the foundation model created by the user as 
shown in Fig. 4.14. This drawing will be helpful for reviewing pile groups, especially battered piles 
involved in the model. 
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Figure 4.16  View Geometry menu – Three-dimensional view 
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5.1 Introduction  
 The design of foundations for vibrating machines and foundations subject to other dynamic 
forces requires an accurate prediction of the foundation response to these loads. A complete and 
rigorous analysis must account for the following: the three-dimensional nature of the problem, material 
and radiation damping of soil, variation of soil properties with depth, embedment effects, and 
interaction effects between multiple foundations through the soil. 

 The dynamic stiffness of foundations is also referred to as the impedance function of the 
foundations under dynamic loading. In current methods of dynamic analysis of soil-foundation-structure 
systems under seismic or machine-type inertial loading, a key step is to estimate the (dynamic) 
impedance functions associated with a rigid but massless foundation. During the past 20 years, a 
number of techniques have been developed for computing and using foundation impedances; extensive 
reviews of these developments were presented by Lysmer (1978), Roessett (1980a, b), Luco (1982), 
Gazetas (1983), Novak (1987), and Pais and Kausel (1988). 

 The presently available methods include: (1) analytical solutions based on integral transform 
techniques; (2) semi-analytical and boundary- element formulations requiring discretization of only the 
top surface; (3) dynamic finite-element methods using special wave-transmitting lateral boundaries; and 
(4) hybrid methods combining analytical and finite element approaches. 

 A comprehensive summary on the behavior of shallow rigid foundations under dynamic loads 
was recently presented by Gazetas in 1991. In the paper, Gazetas introduced general terminology to 
define the impedance functions (dynamic stiffness) of surface and embedded foundations. He 
additionally suggested an approximation based on formulas and charts published in the technical 
literatures to calculate the impedance functions for the practicing engineer. 

 

5.2 Definition of Impedance Functions 
 The geometry of the rigid but massless foundations addressed in Gazetas’s (1991) paper is 
sketched in Fig. 1(a) (surface foundation) and in Fig. 1(b) (embedded foundation). The steady-state 
response of such systems to harmonic external forces and moments can be computed with well-
established methods of structural dynamics once the matrix of dynamic impedance functions [S(ω)] has 
been determined for the frequency(ies) of interest. 

 For each particular harmonic excitation, the dynamic impedance is defined as the ratio between 
force (or moment) R and the resulting steady-state displacement (or rotation) U at the centroid of the 
base of the massless foundation. For example, the vertical impedance is defined by 

Sz = Rz(t) /Uz(t)   (5.1) 

in which Rz(t) = Rzexp (iwt) = harmonic vertical force; and Uz(t) = Uzexp (iwt) harmonic vertical 
displacement of the soil-foundation interface. The quantity Rz is the total dynamic soil reaction against 
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the foundation; it is made up of normal tractions against the basemat plus shear tractions along any 
vertical side walls. 

 

Figure 5.1  Examples of surface and embedded foundations of arbitrary shapes (from Gazetas, 
1991) 

 Similarly, the following impedances are defined: Sy = lateral swaying impedance (force-
displacement ratio), for horizontal motion in the short direction; Sx = longitudinal swaing impedance 
(force-displacement ratio), for horizontal motion in the long direction; Srx rocking impedance (moment-
rotation ratio), for rotational motion about the long centroidal axis (x) of the foundation basemat; Sry = 
rocking impedance (moment-rotation ratio), for rotational motion about the short centroidal axis (y) of 
the foundation basemat; and St = torsional impedance (moment-rotation ratio), for rotational oscillation 
about the vertical axis (z). 

 Moreover, in mainly embedded foundations, horizontal forces along principal axes induce 
rotational (in addition to translational) oscillations; hence, two more “cross-coupling” horizontal-rocking 
impedances Sx-ry and Sy-rx. They are negligibly small in surface and shallow foundations, but their effects 
may become appreciable for greater depths of embedment owing to the moments about the base axes 
produced by horizontal soil reactions against the side walls. 

 As with most literature, all impedances refer to axes passing through the centroid of the 
foundation basemat-soil interface. Because of the presence of radiation and material damping in the 
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system for all modes of vibration, R is generally out of phase with U. It has become traditional to 
introduce complex notation and to express each impedance in the form 

S = k + i ω C   (5.2) 

in which both k and C = functions of the frequency ω. The real component, k, termed “dynamic 
stiffness,” reflects the stiffness and inertia of the supporting soil; its dependence on frequency is 
attributed solely to the influence that frequency exerts on inertia, since soil properties are practically 
frequency independent. The imaginary component, ωC, is the product of the (circular) frequency ω 
times the ‘‘dashpot coefficient,” C; the latter reflects the radiation and material damping generated in 
the system (due to energy carried by waves spreading away from the foundation and energy dissipated 
in the soil by hysteretic action, respectively). If the coefficient of the soil hysteretic damping (β) is given 
separately, the expression of the dashpot coefficient (Total C) of the foundation system can incorporate 
the β coefficient as: 

Total C = radiation c + 2k(β)/ω    (5.3) 

Eq. 5.2 suggests for each mode of oscillation an analogy between the actual foundation-soil system and 
the system that consists of the same foundation but is supported on a “spring” and “dashpot” with 
characteristic moduli equal to k and C, respectively. A number of powerful computational techniques 
have been developed for calculating the dynamic stiffness and damping coefficients of foundations in 
linear soil. They include analytical approaches such as the integral transform method (Kausel,1974; Luco 
and Westmann, 1971; and Veletsos and Wei, 1971), several rigorous and approximate semi-analytical 
procedures such as the boundary element method (Dominquez and Roesset, 1978), and dynamic finite 
elements (Kausel, 1974; Lysmer and Kuhleymeyer, 1969). These techniques can be applied to the 
analysis of machine foundations and to other dynamic soil-structure interaction problems encountered 
in earthquake and offshore engineering. Although further extensions and refinements of these methods 
are being published continuously, they have already attained a great degree of sophistication and may 
handle foundation and soil configurations of great complexity. Shallow foundations can be solved for 
different vibration modes, for exciting forces covering a wide range of frequencies, and for soil 
conditions ranging from a uniform deposit to an arbitrary layered profile on rigid rock. 

 

5.3 Simplified Methods 
 Over the years, several researchers have developed simplified methods, presented results in 
dimensionless graphical or tabular form, or fitted simple equations to their numerical results. The 
classical example of such a simple method is the single-degree-of-freedom with frequency-independent 
parameters proposed in 1966 by Lysmer and Richart for the vertical vibration of a rigid circular footing 
on an elastic halfspace. Similar simple systems or “analogs” were later developed for the other modes of 
vibration of the same circular footing, and these analogs are widely used today (Richart et al, 1970; 
Whitman and Richart, 1967). Later, Kausel, Novak, Roesset, Veletsos and others have fitted equations 
and charts to their analytical results and have proposed simple procedures to take into account the 
variation with frequency of the equivalent dynamic springs and dashpots, and the influence of factors 
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such as embedment and presence of a shallow rigid rock base (Kausel, 1974;Novak and Beredugo, 1971; 
Roesset, 1980; Veletsos and Wei, 1071; and Veletsos and Verbic, 1974). 

 These simple methods, based on physically sound, conceptual frameworks and calibrated with 
exact solutions, are feasible and should be encouraged. These simple methods are very helpful in 
performing parametric studies, checking the results of complicated computer codes and developing 
engineering insight into the expected dynamic behavior of foundation systems. However, these 
methods are only for reasonably deep and uniform soil deposits that can be modeled as a homogeneous 
half-space. 

 In practical applications, the selection of an appropriate method depends to a large extent on 
the size and economics of the project, as well as the availability of pertinent computer codes. Moreover, 
the method to be selected must adequately reflect the following key characteristics of the foundation-
soil system and the excitation. 

• The shape of the foundation-soil interface (circular, strip, rectangular, arbitrary). 

• The amount of embedment (surface, partially or fully embedded foundation, piles). 

• The nature of the soil profile (deep uniform or layered deposit, shallow stratum over bedrock). 

• The mode of vibration and the frequency(ies) of excitation. 

 

5.4 Improved Novak’s Method With Non-Reflective Boundary 

5.4.1 Deep Foundation (Pile Option) 
 Both theoretical and experimental studies have shown that the dynamic response of the piles is 
very sensitive to the properties of the soil in the vicinity of the pile shaft. The measured dynamic 
response of a single pile was compared with the computed curves and shown in Fig. 5.2 (Han and Novak, 
1988). 

 A number of approaches are available to account for dynamic soil-pile interaction, but they are 
usually based on the assumption that the soil behavior is governed by the law of linear elasticity or 
viscoelasticity and that the soil is perfectly bonded to a pile (Novak, 1991). In practice, however, the 
bonding between the soil and the pile is rarely perfect, and slippage or even separation often occurs in 
the contact area. Furthermore, the soil region immediately adjacent to the pile can undergo a large 
degree of straining, which would cause the soil-pile system to behave in a nonlinear manner. 

 A rigorous approach to the non-linearity of a soil-pile system is extremely difficult and time 
consuming. Approximate theories, therefore, have to be used for practice. As for the approximate 
analysis, The Baranov-Novak method is generally considered as an efficient technique for solving the 
problem of coupled vibration (Luco 1982). The relationship between the foundation vibration and the 
resistance of the side soil layers was derived using the elastic theory of Baranov (1967). 
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 Novak and Sheta (1980) proposed including a cylindrical annulus of softer soil (an inner 
weakened zone or so called boundary zone) around the pile in a plane strain analysis. One of the 
simplifications involved in the original boundary zone concept was that the mass of the inner zone was 
neglected to avoid the wave reflections from the interface between the inner boundary zone and the 
outer zone. To overcome this problem, Velestsos and Dotson (1988) proposed a scheme that can 
account for the mass of the boundary zone. Some of the effects of the boundary zone mass were 
investigated by Novak and Han (1990), who found that a homogeneous boundary zone with a nonzero 
mass yields undulation impedance due to wave reflections from the fictitious interface between the two 
media. 

 

Figure 5.2  Predicted and measured horizontal response curves (Han and Novak, 1988, “Dynamic 
behavior of single piles under strong harmonic excitation”, Canadian Geotechnical J., 25 (3), 523-534))  
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The ideal model for the boundary zone should have properties smoothly approaching those of the outer 
zone to alleviate wave reflections from the interface. Consequently, Han and Sabin (1995) proposed 
such a model for the boundary zone with non-reflective interface. A model of the boundary zone with 
non-reflective interface is shown in Fig. 5.3. The model of non-reflective interface assumes that the 
boundary zone has a nonzero mass and a smooth variation into the outer zone by introducing a 
parabolic variation function, which may be best fit with use of experimental data. Dynamic 
investigations of piles indicated that the boundary zone model is applicable to both granular and 
cohesive soils (El-Marsafawi et al, 1992; Han, 1997). 

 

Figure 5.3   Concept of boundary zone with non-reflective interface  

 

 The analytical solution of the non-reflective boundary model is combined with the numerical 
solution in DYNAN program. With the impedance of the soil layer, the element stiffness matrix of soil-
pile system can be formed in the same way as the general finite element method. Then the overall 
stiffness matrix of a single pile can be assembled for different modes of vibration, included three 
translations and three rotations. 
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 The stiffness and damping factors for vertical vibrations, Sν1, and Sν2, obtained from the present 
analysis are compared with those obtained for the Novak-Sheta (N-S) and Veletsos-Dotson (V-D) 
idealizations, as shown in Fig 5.4. These solutions are for a soil layer with tm/r0 = 1.0; Gi/G0 = 0.25; βi = 
0.1 and β0 = 0.05. The mass density for the inner zone is taken to be equal to that for the outer region in 
the present solution and the V-D solution; for the N-S solution the mass density for the inner zone is 
assumed to be zero, an unrealistic assumption. It can be observed that the three sets of results are 
significantly different; the V-D solution results in pronounced oscillations (undulations) caused by wave 
reflections from the interface between the two media. It should be noted that Veletsos and Dotson 
(1988) also included a model with a continuously increasing shear modulus with radial distance to 
remove the undulations in the impedances. The differences between the present solution and that 
solution are that the modulus was varied unboundedly, i.e., without a boundary zone in their model, 
and in the present model the modulus varies only in the boundary zone and is constant in the outer 
zone as one might expect. The nonreflective boundary between the boundary zone and the outer zone 
is formulated in the present solution. It should be explained that the convergence of the power series 
used to express the displacement in this study is rapid; however, the convergence for the derivative of 
the series is slow. To obtain a satisfactory solution, the first 10 to 12 terms of the series are needed. The 
results from the present analysis are smooth curves over a wide range, the value of ai from 0.0 to 4.0, 
which indicates that the wave reflections from the interface are alleviated because it embodies a 
continuous variation in soil properties in the boundary zone with smooth (continuous derivatives) 
transition into the outer zone. For comparison, the results for a homogeneous layer are also included in 
Fig. 5.4. 
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Figure 5.4   Comparison of impedance functions for vertical vibration with Novak-Sheta (N-S) and 
Veletsos-Dotson (V-D) solutions, tm/to=1.0; Gi/Go=0.25; βo=0.05; (a) stiffness factor Sν1 ans (b) 

damping factor Sν2 

 The stiffness and damping factors for torsional vibrations, Sθ1 and Sθ2, obtained from the 
present analysis are compared with those obtained for the Novak-Sheta (N-S) and Veletsos-Dotson (V-D) 
idealizations, as shown in Fig. 5.5. These solutions are for a soil layer with tm/r0 = 1.0; Gi/G0 = 0,25; βi = 
β0 = 0.0. The mass density for the inner zone is taken to be equal to that for the outer region in the 
present solution and the V-D solution; for the N-S solution the mass density for the inner zone is 
assumed to be zero. It can be observed that similar to the case of vertical vibration, the V-D solution 
results in pronounced oscillations (undulations) caused by wave reflections from the interface between 
the two media. In the same way as in the vertical vibration case, Veletsos and Dotson (1988) proposed a 
continuously increasing shear modulus to eliminate the undulations in the impedances. The results from 
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the present analysis are smooth curves over a wide range parameter values, indicating that the wave 
reflections from the interface have been removed. For comparison, the results for a homogeneous layer 
are also included in Fig. 5.5. 

 

Figure 5.5   Comparison of torsional impedance functions with Novak-Sheta (N-S) and Veletsos-
Dotson (V-D) solutions, tm/ to=1.0; Gi/Go=0.25; βi=βo=0.05; (a) stiffness factor Sν1 ans (b) damping 

factor Sν2 

 

The results from the present analysis are smooth curves over a wide range parameter values, indicating 
that the wave reflections from the interface have been removed. For comparison, the results for a 
homogeneous layer are also included in Fig. 5.5. 

 Dynamic investigations of piles indicated that the boundary zone model is applicable to both 
granular and cohesive soils (El-Marsafawi et al., 1992; Han, 1997). The harmonic vibration tests of a full-
scale pile were conducted on the campus of the University of Western Ontario. The soil consisted of a 
layered noncohesive stratum of silty fine sand with a gravel seam, resting on the dense silty till at a 
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depth of 2.9 m from the ground surface. Measurement of shear wave velocity at the site was conducted 
using the cross-hole technique and the steady-state vibration technique. The shear-wave velocity in the 
top 0.5-m soil layer was lower due to the loss of confining pressure toward the surface, and an average 
value of 65 m/s was taken in the analysis. A linear distribution of the shear wave velocity was observed 
for depths below 0.5 m, with 80 and 180 m/s corresponding to depths of 0.5 and 2.9 m. The bulk 
densities of the noncohesive soil and the underlying till were 1,780 and 1,960 kg/m3, respectively. 
Details of the experiment were reported by El-Marsafawi et al. (1992), but the nonlinear effects of the 
soil-pile system were not accounted for. In the new study, the nonlinear effects were observed and 
investigated to verify the validity of the boundary-zone model with non-reflective interface. 

 The pile is a steel pipe having a length of 2.9 m, an outside diameter of 101.6 mm, and wall 
thickness of 6.35 mm. Poisson’s ratio for the pile is assumed to be 0.25 and the damping ratio is 0.005. 
The length-to-diameter ratio of the pile L/d = 28.5 and Ep/Es = 1,370, where Es is the soil elastic 
modulus. The pile was provided with conical plugs and driven hydraulically to a depth of 2.75 m below 
the ground surface. The total mass of the pile cap and exciter is 1,035 kg, and the bottom face of the cap 
is 0.15 m above the ground surface. 

 The soil below the pile tip is considered as an elastic half-space, having a shear wave velocity of 
190 m/s and a unit weight of 1,900 kg/ m3. The measured results under different excitation intensities 
are shown in Fig. 5.6. The maximum vertical displacement amplitude was measured to be 0.07 mm, and 
the maximum acceleration was 0.57 g. This is a smaller amplitude vibration but has strong acceleration. 
From Fig. 5.6 it can be seen that the resonant frequency is 50 Hz under an excitation intensity of me e = 
2.45 kg-mm, 47 Hz under an excitation of 4.92 kgmm, and 45 Hz under an excitation of 9.84 kg-mm. Due 
to the repeated and strong excitation, even at very small amplitudes, the pile-soil system was softened 
so that the resonant frequencies reduced with the increase of excitation intensities. Obviously, the 
nonlinear behavior occurred in the dynamic response of the pile-soil system, say moderate nonlinear 
effects, although it is not a very strong nonlinear response. 

 The boundary-zone model with non-reflective interface is used to simulate dynamic response of 
the pile in nonlinear soil. Comparisons of the theoretical predictions by DYNAN with the measured data 
in different excitations are shown in Fig. 5.6. 
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Figure 5.6  Measured dynamic response of a pile subjected to different excitation intensities 

 

 The analytical solution of non-reflective boundary model is combined with the numerical 
solution in DYNAN program. With the impedance of the sail layer, the element stiffness matrix of soil-
pile system can be formed in the same way as the general finite element method.Then the overall 
stiffness matrix of a single pile can be assembled for different modes of vibration, including three 
translations and three rotations. 

 The group effect of piles is accounted for using the method of interaction factors in the DYNAN 
program. The vertical static interaction factors are based on fitting the charts of Poulos and Davies 
(1980). The horizontal static interaction factors are due to El-Sharnouby and Novak (1986). The dynamic 
interaction factors are derived from the static interaction factors multiplied by a frequency variation, 
and the frequency variation of interaction factors is based on the charts of Kaynia and Kausel (1982). 
The pile foundation with rigid cap is shown in Fig. 5.7. 
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Figure 5.7  Pile foundation model with a rigid cap 

 

5.4.2 Shallow Foundation 

5.4.2.1 Footing on homogeneous halfspace 
In the option shown in Fig. 5.8, the footing rests on the surface of, or is embedded in a deep 

homogeneous deposit considered as halfspace. A stratum whose depth is greater than about five 
equivalent footing radii may be treated as halfspace using this option. The vibration of embedded 
foundation was investigated by many researchers, such as Roesset (1980), Gazetas (1983), Han (1983), 
Wolf and Weber (1986).  

 

Figure 5.8  Footing on homogeneous halfspace 
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 Comparisons of the predictions with the measured data for different embedments are shown in 
Fig. 5.9 for horizontal vibration and Fig. 5.10 for rocking vibration. For details see Han (1989), “Coupled 
Vibration of Embedded Foundation,” J. of Geotechnical Eng., ASCE, 115 (9), 1227-1238. 

 

 

Figure 5.9  Theorectical response curves calculated by Han (1989) and measured data for 
horizontal displacement at top of foundation 

 

 Dynamic experiments were conducted in the field to determine the behavior of an embedded 
foundation. The soil in situ was a sandy clay of yellow and brown color extending from the ground 
surface to a depth of 18 m. The soil properties within 5 m of the ground surface are: mass density, ρ = 
1,700 kg/m3, void ratio, e = 0.95, Poisson’s ratio, ν = 0.3; and shear wave velocity, Vs = 130-150 m/s. 

 The experimental foundation consisted of a concrete block with dimensions of 150 × 150 × 150 
cm3 and weight of 82.8 kN, The square foundation is regarded as circular footing with equivalent radius 
of 84.6 cm in analysis. The foundation was constructed in a pit 3.0 m long, 3.0 m wide and 1.5 m deep. 
The void between the foundation and the side soil was backfilled in three stages, at each stage about 
one third the depth of the pit was filled. Tests were conducted at four stages of backfill height: 0.00 cm, 
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45 cm, 105 cm and 145 cm. Thus, the embedment ratios used for testing were δ = l/r0 = 0,00, 0.53, 1.24 
and 1.71 respectively. As δ = 0.00, the foundation is considered to rest on the surface of the elastic half-
space. 

 

Figure 5.10  Theorectical response curves calculated by Han (1989) and measured data for rocking 
displacement of foundation 

 

 An exciter with two counter-rotating eccentric masses was used to produce horizontal harmonic 
excitation at the top of the foundation. The amplitude converted for the exciting force was 450 N in this 
analysis. The displacement pickups were arranged on top of the footing so as to measure the horizontal 
and rocking vibrations. The dynamic response of the foundation was measured for the four cases of 
embedment noted previously. 

5.4.2.2 Footing on homogeneous layer (Stratum) 
 For the option shown in Fig. 5.11, the footing rests on the surface of, or is embedded in, a 
shallow, homogeneous layer underlain by a rigid medium (bedrock). The layer stiffness and damping 
constants are calculated using the formulae due to Kausel and Ushijima (1979). The most prominent 
feature of this case is that the geometric damping of the foundation can be considerably reduced if the 
dominant frequency of the response is lower than the first natural frequency of the layer. The material 
damping becomes to be important and should be considered. 
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 The range of problem parameters is limited. Such as, the ratio of embedment depth h with layer 
depth H should be h/H < 0.75, and R/H < 0.5 (as shown in Fig. 5.11), where R is the equivalent radius of 
footing. 

 

Figure 5.11  Footing on homogeneous layer (Stratum) 

 

5.4.2.3 Footing embedded in layered medium 
 This option as shown in Fig. 5.12 is for a rather deep footing such as a caisson that may be 
embedded in and underlain by a layered medium. The properties of the soil layers may be different but 
constant within each layer except for the soil column under the footing in which the soil properties may 
differ from those of the outer part of the layer. This feature makes it possible to take an approximate 
account of the increased confining pressure under the footing. 

 

Figure 5.12  Footing embedded in multi-layered medium 
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 This option is treated as a special case of a thick pile and should not be applied to a shallow 
foundation. For instance, the embedment depth of foundation E should be E/R > 2 and the total 
foundation length h (included the soil column under the foundation) should be h > 5R (as shown in Fig. 
5.12), where R is the equivalent radius of footing. 

5.5 Dynamic Loading 
 A rigid body can be supported by any of the above types of foundation and be analyzed for the 
three types of loading. These are transient, random and harmonic loading. All loads are referred to the 
reference point, usually the center of gravity of the whole system (including the machine, if present) and 
can act in all six degree of freedom. 

5.5.1 Transient Loading 
 An irregular but specific time history of limited duration, characterizes transient loading. Some 
machines such as crushers, pumps, hammers or presses and can cause such a loading, as well as by 
earthquakes, blasts, and explosions. 

 The response to transient loading is also transient and is calculated using the Fast Fourier 
Transform (FFT). Information on this method can be found from Clough and Penzien (1975). 

 The program returns the complete time history of the response in six degree of freedom as well 
as its maximum. 

5.5.2 Random Loading 
 Random loading is characterized by an irregular time history, which is best described by the 
corresponding power spectral density (power spectrum). The random excitation included in DYNAN is 
assumed to be stationary, i.e., its statistical characteristics do not vary with time. This type of loading 
may stem, for example, from crushers, pumps, traffic, and wind and approximately from earthquakes. 

 Its power spectral density given for a number of points (frequencies) describes the excitation. 
The maximum number of data points is 200. The program returns the mean peak values of the response 
expected to occur during the period of observation T. This peak value of the response is 

Qi = g su    (5.4) 

In which g is the peak factor and su is the standard deviation (rootmean-square value) of the response. 
The peak factor is calculated from the spectra. The period T may typically be 20 to 60 seconds for 
earthquakes and 600 to 3600 seconds for machine or wind loading. 

5.5.3 Harmonic Loading 
 Harmonic loading is caused by unbalanced masses of rotating and reciprocating machines such 
as turbines, generators, compressors, fans, diesel engines and many others. It is the most common type 
of excitation. This excitation may have one harmonic component and consequently, a sinusoidal time 
history, or more harmonic components. If there are more harmonic components the response has to be 
calculated for each component separately and the results added. 
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 In DYNAN, the harmonic excitation can be of two types: the constant amplitude excitation and 
the frequency dependent or quadratic excitation. 

The constant amplitude excitation is defined as 

P(t) = Po sin ωt    (5.5) 

 

In which Po is the excitation force amplitude, w is the circular frequency of excitation and t is time. 

 The quadratic excitation is more often present and is usually caused by centrifugal forces of 
rotating unbalanced masses and is defined as 

P(t) = meeω2 sin ωt    (5.6) 

In which me is unbalanced mass, e is eccentricity and ω is circular frequency. This type of excitation is 
defined by mee and the frequency range. 

 

5.6 Available Methods for Dynamic Analysis of Shallow and Deep 
Foundations. 

 Dynamic behaviors of foundations have been observed under earthquake, wind, blast, waves 
and vibrating machines. In many cases, a large dynamic response will cause the superstructure or the 
machine system to fail. A number of approaches are available to account for dynamic soil-pile 
interaction but they are usually based on the assumption that the soil behavior is governed by the law of 
linear elasticity or visco-elasticity and the soil is perfectly bonded to a pile. In practice, however, the 
bonding between the soil and the pile is rarely perfect and slippage or even separation often occurs in 
the contact area. Furthermore, the soil region immediately adjacent to the pile can undergo a large 
degree of straining, which would cause the soil-pile system to behave in a nonlinear manner. 

5.6.1 Finite element or boundary element method 
 Many efforts have been spent on the numerical analysis to model the soil-pile interaction using 
the Finite Element Method (FEM) or boundary element method. Both the pile and the soil are modeled 
by solid elements. However, it is too complex, especially for group piles in nonlinear soil. A rigorous 
approach to the nonlinearity of a soil-pile system is extremely difficult and time consuming. 

5.6.2 Impedance Function method 
 Both theoretical and experimental studies have shown that the dynamic response of piles is very 
sensitive to the properties of the soil in the vicinity of the pile shaft ( Han and Novak, 1988). The 
impedance functions are derived for the soil-pile system based on a boundary zone model with non-
reflective interface by Han and Sabin (1995). The soil properties in the boundary zone (near field) may 
be different from that in the far field to indicate the nonlinearity of soil. The procedure is a half 
analytical and half numerical solution, and details are described by Han (1997). DYNAN program is 
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developed based on the impedance function method and uses the model of soil-structure interaction 
with nonreflective boundary between the near field and the far field to account for the nonlinearity of 
soil. 

 The program computes dynamic response of both shallow and deep foundations under dynamic 
loading. The foundation stiffness and damping constants are also computed for possible use in soil-
structure interaction analysis for simulating the dynamic behavior of the structures (such as bridges, 
high-rise buildings, and wind-turbine towers). Soil layering, boundary zone around embedded 
foundations and piles, pile interaction in a group and other features can be considered in this method. 
To simplify the input data related to soil properties of the weak zone, the program only requires the 
user to enter the ratio of the weak-zone shear modulus over the non-weak-zone shear modulus in 
Version 3. The program will assume the thickness (lateral distance from the pile) of the weak zone is 
equal to the pile radius. The Poisson’s ratio is unchanged.  

 The soil in the weak zone usually has a high damping ratio. Therefore, the program will use the 
damping ratio in the weak zone to be twice of the damping ratio in the original soil. The foundations (or 
caps of pile) are assumed to be rigid, and all six degrees of freedom are considered as coupled. It should 
be noted that, in most cases, the superstructures are flexible rather than rigid. The substructure concept 
based on the impedance function of foundations has been introduced in the structural analysis and is 
frequently used by the structural engineers for the time-history analysis in seismic studies. By means of 
the substructure method, the dynamic response of the superstructure is analyzed using a nonlinear 
finite-element program, such as SAP2000 or other similar one, and the real part and the imaginary part 
of the foundation stiffness generated by Dyna-N program being entered as the boundary condition, 
which represent the substructure in modeling.. 

 The superstructure can be subject to harmonic, transient and random loading, and the stiffness 
and damping of the foundation can be generated in frequency domain from this program. 

                                                     COPYRIGHT © ENSOFT, INC 2012 
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTHORIZATION FROM ENSOFT, INC



 

 

 

 

 

 

 

 

 

 

 

CHAPTER 6. Example Problems 
  

                                                     COPYRIGHT © ENSOFT, INC 2012 
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTHORIZATION FROM ENSOFT, INC



CHAPTER 6    Example Problems    6-2 

 

Dyna-N 3.0 for Windows User's Manual 
 

6.1 Example 1: Harmonic Load Applied to Half-Space (Embedded 
Foundation) 

A reciprocating compressor was installed on a concrete block foundation (half-space), with a primary 
frequency of 7 Hz and a secondary frequency of 14 Hz. The dynamic response under the primary 
frequency is calculated in this example. 

The foundation base is 7.5 m by 5.3 m with a thickness of 0.7 m, as shown in the figure. The embedment 
is 0.7 m. The shear wave velocity of the side soil is 150 m/s. The shear wave velocity of soil beneath the 
foundation is 205 m/s. 

In this example, the unit for force is KN; for mass it is Mg and for length it is m. The total mass is 266.8 
Mg (included machine mass). The height of C.G. (Center of Gravity) is 2.234 m. The nonquadratic 
harmonic response is calculated. Use SI units: kN, Mg = 1,000 kg, m. 

 

Figure 6.1   Dimension of the foundation for seismic response analysis demonstrated in Example 1 
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6.1.1 Input Data 
 
TITLE= RECIPROCATING COMPRESSOR FOUNDATION (KN-Mg-m) 
MATRIX 
GRAVITY=9.8 
FOUNDATION=HALF-SPACE 
RECTANGULAR=7.5,5.3 
MASS  
266.8 1302 1552 1207 0 0 0 
CONSTANTS  
0 0.34 2.234  
SOIL  
WEAK  
CONSTANTS=1 
1 0.7 150 17 0.3 0.05 0.5 0.3 0.1 1 
BELOW=205 18 0.3 0.05 
LOAD  
HARMONIC  
CONSTANTS  
NONQUADRATIC  
125.6 6.28 6.28 0.805 0 0.378 7.802 6.357 -15.53 
RUN  
0 
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000 
 
 

6.1.2 Output Results 
 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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6.2 Example 2: Harmonic Load Applied to Pile Foundation 
The pile cap is a 2.5 m (length) by 1.6 m (width) by 0.5 m (thickness) concrete block, with a total mass of 
5,000 kg. Six concrete piles are fixed to the cap, each with a diameter of 0.32 m and a length of 7.5 m.  

The soil is divided into 8 layers. The top layer (0.25 m) is a void. 

The dynamic pile-soil-pile interaction is accounted for. The horizontal response is calculated in a 
frequency domain from 5 Hz (ω = 31.4) to 30 Hz (ω = 188.4) 

Use SI units: kN, mg, m. 

 

Figure 6.2   Pile foundation for dynamic response analysis demonstrated in Example 2 

 

6.2.1 Input Data 
TITLE=DYNAMIC RESPOSE OF PILE GROUP (kN-Mg-m) 
MATRIX 
GRAVITY=9.8 
FOUNDATION=PILE 
RECTANGULAR=2.5,1.6 
MASS  
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5 1.17 2.71 3.87 0 0 0 
LAYERS=8 
FIXED=6 
1 -0.9 0.45  
2 0 0.45  
3 0.9 0.45  
4 0.9 -0.45  
5 0 -0.45  
6 -0.9 -0.45  
CONSTANTS  
0 0 0.26 7.5 24.5  
50 0.25 0.01 1.334 27000000 
ELEMENT 
1 0.25 0.16 0.16 0.0804 0.000515 0.000515 0.00103 
2 1 0.16 0.16 0.0804 0.000515 0.000515 0.00103 
3 1 0.16 0.16 0.0804 0.000515 0.000515 0.00103 
4 1 0.16 0.16 0.0804 0.000515 0.000515 0.00103 
5 1 0.16 0.16 0.0804 0.000515 0.000515 0.00103 
6 1 0.16 0.16 0.0804 0.000515 0.000515 0.00103 
7 1 0.16 0.16 0.0804 0.000515 0.000515 0.00103 
8 1.25 0.16 0.16 0.0804 0.000515 0.000515 0.00103 
FLOATING 
INTERACTION  
SOIL  
WEAK 
CONSTANTS 
1 0 0 0 0 0 0 0 1 
2 130 20.2 0.3 0.035 0.5 0.3 0.07 1 
3 193 20.2 0.3 0.035 0.5 0.3 0.07 1 
4 200 18.5 0.3 0.035 0.5 0.3 0.07 1 
5 180 18.5 0.3 0.035 0.5 0.3 0.07 1 
6 234 19.7 0.3 0.035 0.5 0.3 0.07 1 
7 272 19.7 0.3 0.035 0.5 0.3 0.07 1 
8 272 20 0.3 0.035 0.5 0.3 0.07 1 
BELOW=280 20 0.3 0.035 
LOAD  
HARMONIC  
CONSTANTS  
QUADRATIC  
188.4 31.4 6.28 0 0.000259 0 -0.000114 0 0 
RUN  
0 
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000 
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6.2.2 Output Results 
 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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6.3 Example 3: Pile Foundation of a Tall Building 
To calculate the seismic response of a 20-story building as shown in Figure 6.3, a substructure method is 
used. The detailed analysis is described by Han and Cathro (1997), “Seismic Behavior of Tall Buildings 
Supported on Pile Foundations”, ASCE, Geotechnical Special Publication No. 70, 36-51. 

In this example, the stiffness and damping of the pile foundation are shown. The pile cap is a 11.5 m 
(length) by 11.5 m (width) by 1.2 m (thickness) concrete block, with a mass of 387,000 kg. Twenty-five 
concrete piles are fixed to the cap, each with a diameter of 0.4 m and a length of 24 m. 

The soil is divided into 7 layers. The boundary zone around the pile is included to simulate a seismic 
environment.  The dynamic pile-soil-pile interaction is accounted for. The stiffness and damping of pile 
group are shown at a frequency W = 5.0 (0.8 Hz) that is a main frequency for the seismic input in this 
case. 

 

Figure 6.3   Foundation dimension for seismic response analysis demonstrated in Example 3 
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6.3.1 Input Data 
 

TITLE=PILE FD. OF TALL BUILDING (kN-Mg-m) 
MATRIX 
GRAVITY=9.8 
FOUNDATION=PILE 
RECTANGULAR=11.5,11.5 
MASS  
387 4450 4450 8530 0 0 0 
LAYERS=7 
FIXED=25 
1 -5.5 5.5  
2 -2.75 5.5  
3 0 5.5  
4 2.75 5.5  
5 5.5 5.5  
6 -5.5 2.75  
7 -2.75 2.75  
8 0 2.75  
9 2.75 2.75  
10 5.5 2.75  
11 -5.5 0  
12 -2.75 0  
13 0 0  
14 2.75 0  
15 5.5 0  
16 -5.5 -2.75  
17 -2.75 -2.75  
18 0 -2.75  
19 2.75 -2.75  
20 5.5 -2.75  
21 -5.5 -5.5  
22 -2.75 -5.5  
23 0 -5.5  
24 2.75 -5.5  
25 5.5 -5.5  
CONSTANTS  
0 0 0.6 24 24  
886 0.25 0.02 1.334 27000000 
ELEMENT 
1 2 0.2 0.2 0.1256 0.001256 0.001256 0.002512 
2 2 0.2 0.2 0.1256 0.001256 0.001256 0.002512 
3 3 0.2 0.2 0.1256 0.001256 0.001256 0.002512 
4 5 0.2 0.2 0.1256 0.001256 0.001256 0.002512 
5 3 0.2 0.2 0.1256 0.001256 0.001256 0.002512 
6 7 0.2 0.2 0.1256 0.001256 0.001256 0.002512 
7 2 0.2 0.2 0.1256 0.001256 0.001256 0.002512 
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FLOATING 
INTERACTION  
SOIL  
WEAK 
CONSTANTS 
1 0 19 0.3 0.05 0.25 0.3 0.1 1 
2 90 18 0.3 0.05 0.25 0.3 0.1 1 
3 150 19.5 0.3 0.05 0.25 0.3 0.1 1 
4 180 19.5 0.3 0.05 0.25 0.3 0.1 1 
5 210 18 0.3 0.05 0.25 0.3 0.1 1 
6 210 19 0.3 0.05 0.25 0.3 0.1 1 
7 240 20 0.3 0.05 0.25 0.3 0.1 1 
BELOW=460 22 0.3 0.05 
LOAD  
HARMONIC  
CONSTANTS  
QUADRATIC  
25 5 1 0 1 0 0 0 0 
RUN  
0 
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000 
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6.3.2 Output Results 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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6.4 Example 4: Seismic Loads applied to Half-Space Foundation (Transient 
Load) 

A 2-story concrete frame structure is seated on a homogeneous halfspace. A substructure method can 
be used to calculate the seismic or dynamic response of the flexible superstructure. A detailed analysis 
procedure is described by Han et al (1999) “Design of an Elevated Compressor Table Top Structure 
Considering Soil-Pile-Structure Interaction”, 27 Annual Conference of Canadian Society for Civil 
Engineering, 291-300. 

In this example, the frame is assumed as a rigid structure in order to show how to use the program for 
calculating the seismic response of a half-space foundation (transient load). 

The foundation is a concrete block that is 5 m (length) by 5 m (width) by 1.0 m (thickness). The total 
mass of frame structure and foundation is 152.5 mg, and the height of C.G. is 2.81 m. 

The foundation rests on half-space. The depth of the embedded side soil is 1.0 m. 

A seismic time history record is used as transient load input. The number of points is 1024, and the time 
interval between points is 0.02 second. One type of load is input, horizontal force in y-direction. The 
1024 input loads are the ground acceleration multiplied by mass. 

Use SI units: kN, Mg, m. 

6.4.1 Input Data 
 

TITLE= SEISMIC LOADS HALF-SPACE (kN-Mg-m) 
MATRIX 
GRAVITY=9.8 
FOUNDATION=HALF-SPACE 
RECTANGULAR=5,5 
MASS  
152.5 1151 1151 600.4 0 0 0 
CONSTANTS  
0 0 2.81  
SOIL  
CONSTANTS=1 
1 1 120 17 0.3 0.05 
BELOW=180 18 0.3 0.05 
LOAD  
TRANSIENT  
CONSTANTS  
1024  
0.02  
1  
2  
839.70636  
404.30304  
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-1057.408  
-248.80188  
217.70165  
-622.0047  
-31.100235  
342.10257  
-186.60141  
-870.80658  
-559.8042  
-497.60376  
-1586.1119  
-2799.0212  
-2239.2168  
-373.20282  
1368.4103  
2177.0164  
1648.3124  
-62.20047  
-1586.1119  
-2674.6204  
-2394.718  
-497.60376  
901.9068  
653.10492  
124.40094  
901.9068  
2145.9163 
------------ 
------------ 
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6.4.2 Output Results 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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6.5 Example 5: Mat Foundation on Stratum under Harmonic Load 
A circular foundation with radius of 5 ft rests on the surface of a stratum of dense sand with a shear 
wave velocity of 643 ft/sec and a unit weight of 112 pcf. A rotating mass machine is fixed on the circular 
foundation, and the total weight of machine and foundation is 140,000 Ib. The height of the C.G. is 5 ft. 

The sand layer is 10 ft thick underlain by bed rock. 

The vertical harmonic response is calculated. The dynamic response is sensitive to the material damping 
of soil for the case of stratum. In this example the material damping ratio is 0.05. Users can change the 
value of material damping to examine the effects on dynamic response. 

Use Imperial units: Ib, slug = Ib/32.2, ft. 

6.5.1 Input Data 
 

TITLE= MAT FOUNDATION ON STRATUM (Ib-Slug-ft) 
MATRIX 
GRAVITY=32.2 
FOUNDATION=STRATUM 
CIRCULAR=5 
MASS  
4348 27200 27200 54350 0 0 0 
CONSTANTS  
0 0 5 0 10  
SOIL  
CONSTANTS  
643 112 0.25 0.05 
LOAD  
HARMONIC  
CONSTANTS  
QUADRATIC  
188.4 6.28 6.28 0 0 0.02282 0 0 0 
RUN  
0 
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000 
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6.5.2 Output Results 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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6.6 Example 6: Shallow Foundation in Layered Soil (Multilayer Option) 
 

The shallow foundation is a 2.5 m (length) by 1.6 m (width) by 2.3 m (thickness) concrete block 
embedded into layered soil. The soil is divided into 5 layers, including 2 adjacent layers (side soil) and 3 
soil layers beneath the foundation underlain by an elastic halfspace. The boundary zones in the side soil 
are considered around the concrete block. 

Harmonic loads applied to the foundation, and the vertical dynamic response output. 

Use SI units: kN, Mg, m. 

 

 

Figure 6.4   Shallow Ffoundation in layered soils for dynamic response analysis demonstrated in 
Example 6 
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6.6.1 Input Data 
 

TITLE=SHALLOW FOUNDATION IN LAYERED SOIL (kN-Mg-m) 
MATRIX 
GRAVITY=9.8 
FOUNDATION=MULTILAYER 
RECTANGULAR=2.5,1.6 
MASS  
24.5 5.837 13.54 19.375 0 0 0 
LAYER=5 
CONSTANTS  
0 0 1.15 9.3 24.5  
50 0.25 0.01 1.334 27000000 
ELEMENT 
1 0.8 2.5 1.6 4 2.08 0.85 4.13 
2 1.5 2.5 1.6 4 2.08 0.85 4.13 
3 2 2.5 1.6 4 2.08 0.85 4.13 
4 2 2.5 1.6 4 2.08 0.85 4.13 
5 3 2.5 1.6 4 2.08 0.85 4.13 
SOIL  
WEAK  
CONSTANTS=2 
1 90 20.6 0.3 0.05 0.25 0.3 0.1 1 
2 120 18.9 0.3 0.05 0.25 0.3 0.1 1 
3 250 19 0.3 0.05 1 1 
4 280 18 0.3 0.05 1 1 
5 300 19.05 0.3 0.05 1 1 
BELOW=380 21.6 0.3 0.05 
LOAD  
HARMONIC  
CONSTANTS  
NONQUADRATIC  
251.2 6.28 6.28 0 0 1 0 0 0 
RUN  
0 
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000 
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6.6.2 Output Results 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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6.7 Example 7: Random Loads Applied to Half-Space Foundation 
 

Use the same 2-story concrete frame structure as shown in Example 4. The frame is assumed to be a 
rigid structure in order to show how to use the program for calculating the expected peak response of 
the structure rested on half-space (random load). 

The foundation is a concrete block with the following dimensions: 5 m (length) by 5 m (width) by 1.0 m 
(thickness). The total mass of frame structure and foundation is 152,500 kg, and the height of the C.G. is 
2.81 m. 

The foundation rests on half-space. The depth of embedded side soil is 1.0 m. 

A seismic time history record is translated to a power spectrum using the FFT approach. The values of 
the power spectrum are given for 101 points (frequencies). The maximum frequency is w = 125.6 
rad/sec and the minimum frequency is w = 0.01 rad/sec. One spectrum is used in the X-direction. 

Use SI units: kN, mg, m. 

6.7.1 Input Data 
 

TITLE= RANDOM LOADS HALF-SPACE (N-kg-m) 
MATRIX 
GRAVITY=9.8 
FOUNDATION=HALF-SPACE 
RECTANGULAR=5,5 
MASS  
152500 1151000 1151000 600400 0 0 0 
CONSTANTS  
0 0 2.81  
SOIL  
WEAK  
CONSTANTS=1 
1 1 120 17 0.3 0.05 0.5 0.3 0.1 1 
BELOW=180 18 0.3 0.05 
LOAD  
RANDOM  
CONSTANTS  
125.6  
0.001  
101  
20  
1  
1 1 
6337.3  
7856.2  
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8168.1  
13111  
12330  
6463.4  
5533.4  
9609.5  
7627.6  
3522.2  
2636.2  
2398.1  
5065.8  
6971.7  
5004.2  
3898.9  
4187.5  
2754.4  
1417.7  
847.65  
1120.6  
1217.9  
1087  
1046.8  
868.78  
1307.8  
1393.7  
1115.2  
1122.7  
543.33  
441.18  
609.65  
703.71  
481.49  
276.38  
152.16  
154.69  
139.83  
145.73  
101.63  
60.821  
86.569  
123.27  
107.61  
89.154  
53.422  
67.257  
64.295  
57.325  
28.1  
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26.72  
15.903  
15.995  
0  
11.806  
14.962  
20.362  
2.6891  
6.6034  
0  
4.0074  
0  
3.7997  
0 TITLE= RANDOM LOADS HALF-SPACE (N-kg-m) 
MATRIX 
GRAVITY=9.8 
FOUNDATION=HALF-SPACE 
RECTANGULAR=5,5 
MASS  
152500 1151000 1151000 600400 0 0 0 
CONSTANTS  
0 0 2.81  
SOIL  
WEAK  
CONSTANTS=1 
1 1 120 17 0.3 0.05 0.5 0.3 0.1 1 
BELOW=180 18 0.3 0.05 
LOAD  
RANDOM  
CONSTANTS  
125.6  
0.001  
101  
20  
1  
1 1 
6337.3  
7856.2  
8168.1  
13111  
12330  
6463.4  
5533.4  
9609.5  
7627.6  
3522.2  
2636.2  
2398.1  
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5065.8  
6971.7  
5004.2  
3898.9  
4187.5  
2754.4  
1417.7  
847.65  
1120.6  
1217.9  
1087  
1046.8  
868.78  
1307.8  
1393.7  
1115.2  
1122.7  
543.33  
441.18  
609.65  
703.71  
481.49  
276.38  
152.16  
154.69  
139.83  
145.73  
101.63  
60.821  
86.569  
123.27  
107.61  
89.154  
53.422  
67.257  
64.295  
57.325  
28.1  
26.72  
15.903  
15.995  
0  
11.806  
14.962  
20.362  
2.6891  
6.6034  
0  
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4.0074  
0  
3.7997  
0 

6.7.2 Output Results 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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6.8 Example 8: Harmonic Load Applied to Pile Group (Battered Piles 
Included) 

The group consists of 9 piles, of which 6 are battered and 3 are vertical piles, as shown in Figure 6-5. 
Each pile’s diameter is 1.0 m and the length is 24 m. The pile cap is 18 m in length, 14 m in width, and 
1.5 m in thickness, with a total mass of 908 Mg. The height of the C.G. is 0.75 m. The concrete piles are 
fixed to the cap. 

The soil is divided into 7 layers. The top layer (1.5 m) is a void. The boundary zones are considered 
around the piles. The pile cap is embedded by two side soil layers.  The angle between the battered pile 
and vertical is 10 degrees in the XZ plane and 12 degrees in the YZ plane. The positive and negative 
symbols of angle are shown in Figure 6-3. 

The dynamic pile-soil-pile interaction is accounted for. The dynamic response in 6 degree freedoms is 
calculated in a frequency domain from W = 0.01 rad/sec to W = 50.24 rad/sec (8 Hz). 

Use SI units: kN, Mg, m. 

 

Figure 6.5   Pile foundation for dynamic response analysis demonstrated in Example 8 

                                                     COPYRIGHT © ENSOFT, INC 2012 
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTHORIZATION FROM ENSOFT, INC



CHAPTER 6    Example Problems    6-49 

 

Dyna-N 3.0 for Windows User's Manual 
 

 

6.8.1 Input Data 
 

TITLE=BATTERED PILE GROUP UNDER HARMONIC LOAD (KN-Mg-m) 
MATRIX 
GRAVITY=9.8 
FOUNDATION=PILE 
RECTANGULAR=18,14 
MASS  
908 16100 25700 39300 0 0 0 
LAYERS=7 
FIXED=9 
1 -8 6  
2 0 6  
3 8 6  
4 -8 -6  
5 0 -6  
6 8 -6  
7 -8 0  
8 0 0  
9 8 0  
CONSTANTS  
0 0 0.75 30 77  
5000 0.25 0.01 2 27000000 
ELEMENT 
1 1.5 0.5 0.5 0.12 0.0139 0.0139 0.0278 
2 0.5 0.5 0.5 0.12 0.0139 0.0139 0.0278 
3 0.5 0.5 0.5 0.12 0.0139 0.0139 0.0278 
4 0.5 0.5 0.5 0.12 0.0139 0.0139 0.0278 
5 6 0.5 0.5 0.12 0.0139 0.0139 0.0278 
6 10 0.5 0.5 0.12 0.0139 0.0139 0.0278 
7 11 0.5 0.5 0.12 0.0139 0.0139 0.0278 
FLOATING 
BATTERED 
1 XZ   
-10  
2 YZ   
12  
3 XZ   
10  
4 XZ   
-10  
5 YZ   
-12  
6 XZ   
10  
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7 XZ   
0  
8 XZ   
0  
9 XZ   
0  
INTERACTION  
SOIL  
WEAK 
CONSTANTS 
1 0 0 0.45 0.05 0.3 0.45 0.1 1 
2 100 16 0.45 0.05 0.3 0.45 0.1 1 
3 120 17 0.45 0.05 0.3 0.45 0.1 1 
4 140 18 0.45 0.05 0.3 0.45 0.1 1 
5 180 19 0.45 0.05 0.3 0.45 0.1 1 
6 220 20 0.45 0.05 0.3 0.45 0.1 1 
7 250 20 0.45 0.05 0.3 0.45 0.1 1 
BELOW=300 21 0.45 0.05 
EMBEDDED 
2  
1 0.5 100 16 0.3 0.05 
2 0.5 50 16 0.3 0.05 
LOAD  
HARMONIC  
CONSTANTS  
NONQUADRATIC  
50.24 0.01 3.14 5 3 20 -4.5 7.5 0 
RUN  
0 
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000 
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6.8.2 Output Results 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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6.9 Example 9: Validation based on Dynamic Tests on Pile Foundation 
To verify the validity of the boundary zone model, a series of dynamic experiments have been done on 
full-scale piles in the field (see El-Marsafawi et al, 1992). In this study the results from a set of tests on a 
single steel pile are used to verify the validity of the boundary zone model and to estimate the 
parameters of the boundary zone. The details of the experimental setup are described in what follows 
(see Han & Novak, 1988). 

The pile tested was a steel pipe with a diameter of 133 mm and a length of 3.38 m. The pile was placed 
in a pit with a depth of 3.6 m and a diameter of 1.5 m. The pile cap was a concrete block 200 mm thick, 
with a mass of 250 kg. An exciter was fixed on the cap and its mass was 120 kg. The centre of gravity of 
the cap-exciter system was 3 mm below the cap surface. 

The washed medium sand was placed into the pit and compacted. The soil properties were measured in 
the laboratory and in situ for both the sandy-soil fill and the undisturbed natural deposit around the pit. 

The shear wave velocity of sand soil measured was 93 m/s at the pile tip and the mass density was 1700 
kg/m3. It was assumed that the distribution of shear modulus in sand is parabolic with depth. 

The soil profile around the pit was established from the ground surface to a depth of 20 m. The soil was 
homogeneous sandy clay. The shear wave velocity of the clay outside the pit was about twice that of the 
sand backfill and therefore the effect of the interface between the two media had to be assessed. In a 
low frequency domain, the differences in the dynamic deflections were quite small between the two 
cases, a horizontal homogeneous medium comprising of only the sand and a composite medium 
comprising of the inner zone of sand in the pit and the outer zone of clay. 

Displacement pickups, strain gauges and compressive stress transducers were fixed along the pile shaft. 
Displacement and acceleration pickups were mounted on the pile cap. 

A mechanical-type exciter was used to produce the harmonic excitation in both the horizontal and 
vertical directions. The magnitude of the unbalanced force was changed by adjusting the angle of the 
eccentric masses. In this case, the unbalanced force was 0.0606 w 2 (N), where w is the circular 
frequency. The unbalanced force was increased with w2. 

The displacements were measured on the pile cap at different frequencies as the unbalanced force 
varied from low frequencies to high frequencies. The data from the horizontal amplitudes measured are 
shown by dots in Fig. 6.6. 

The soil is divided into 5 layers. The layer thickness is 0.5 m for the top 4 layers and the bottom layer has 
1.38 m in thickness. For the linear case the boundary zones are not considered and the weak zone shear 
modulus ration should be entered as 1.0. However, the boundary zones are considered around the piles 
for taking into account the nonlinear soil condition.  

The real line (in blue) in Fig.1 represents the response of pile with the boundary zone, and the nonlinear 
property of soil is accounted for. The dash line (in red) represent the response of pile with the linear 
property of soil, Gi /Go  = 1. It can be seen that the real line matches the measured data very well, and 
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the dynamic response calculated is very different for linear soil and nonlinear soil. The frequencies 
corresponding to the peak value and the maximum amplitudes are also varied with the cases of linear 
soil and nonlinear soil. 

 

Use SI units: kN, Mg, m. 

 

Figure 6.6   Comparison of predicted and measured pile amplitudes of a single pile presented in 
Example 9  

 

6.9.1 Input Data 
 

TITLE=Singel Steel Pile, Nonlinear soil 
MATRIX 
GRAVITY=9.8 
FOUNDATION=PILE 
RECTANGULAR=0.77,0.69 

0

0.5

1

1.5

2

2.5

3

0 5 10 15
Frequency (Hz)

A
m

pl
itu

de
 (m

m
)

Nonlinear

Linear Soil

Measured Data

                                                     COPYRIGHT © ENSOFT, INC 2012 
NO REPRODUCTION OR DISTRIBUTION WITHOUT AUTHORIZATION FROM ENSOFT, INC



CHAPTER 6    Example Problems    6-59 

 

Dyna-N 3.0 for Windows User's Manual 
 

MASS  
0.375 0.01831 0.02079 0.02272 0 0 0 
LAYERS=5 
FIXED=1 
1 0 0  
CONSTANTS  
0 0 0.196 3.38 77  
1 0.3 0.02 1.334 2E8 
ELEMENT 
1 0.5 0.0665 0.0665 0.00239 4.84E-6 4.84E-6 9.68E-6 
2 0.5 0.0665 0.0665 0.00239 4.84E-6 4.84E-6 9.68E-6 
3 0.5 0.0665 0.0665 0.00239 4.84E-6 4.84E-6 9.68E-6 
4 0.5 0.0665 0.0665 0.00239 4.84E-6 4.84E-6 9.68E-6 
5 1.38 0.0665 0.0665 0.00239 4.84E-6 4.84E-6 9.68E-6 
FLOATING 
INTERACTION  
SOIL  
WEAK 
CONSTANTS 
1 35 16.7 0.45 0.05 0.03 0.45 0.1 1 
2 35 16.7 0.45 0.05 0.03 0.45 0.1 1 
3 40 16.7 0.45 0.05 0.03 0.45 0.1 1 
4 50 16.7 0.45 0.05 0.03 0.45 0.1 1 
5 70 16.7 0.45 0.05 0.03 0.45 0.1 1 
BELOW=93 16.8 0.3 0.05 
LOAD  
HARMONIC  
CONSTANTS  
QUADRATIC  
94.2 3.14 6.28 0 6.06E-5 6.06E-5 -1.236E-5 0 0 
RUN  
0 
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000 
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6.9.2 Output Results 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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6.10 Example 10: Seismic Response of Vacuum Tower Structure 
A vacuum tower structure shown in Fig. 6.7 was built for a petrochemical plant in a seismically active 
area. Details of the steel structure are described in what follows. Four columns using WWF 400x243 
(400 x 400 mm, weight of 243 kg/m) and a height of 20m are arranged in a rectangle with a center to 
center spacing of 8.55m. The vacuum vessel is supported directly by a top frame using beams of WWF 
1400x358 (1400 x 400 mm, weight of 358 kg/m) on top and beams of W610x155 at bottom. There are 
three layers of beams beneath the top frame and the main beam is W460x82. The concrete mat 
foundation is 12 x 12 m and thickness is 1.2 m. 

The vacuum vessel is modeled as an elastic column with the mass distributed uniformly along its height. 
The steel structure is modeled using frame elements, and the mat foundation is modeled using shell 
elements, as shown in Fig. 6.7. The thickness of the vessel wall is 25.4 mm (one inch). The seismic 
response of the structure is calculated using the substructure method. The deflection of the structure, 
the base shear, and the overturning moments for different base conditions are of importance in the 
design consideration. 

The structure is in a seismically active area, and the range of peak horizontal ground acceleration is 
equal to 0.13 g. At the site, the surface soil is soft clay with a depth of 2 m, followed by a layer of 
saturated fine sand with a depth of 2 m, then some clay, sand, and finally bedrock. The depth to the 
bedrock is about 30 m. Soil properties vary with depth and are characterized by the shear wave velocity, 
Vs, and unit weight, γ, as shown in Table 6.1. 

The washed medium sand was placed into the pit and compacted. The soil properties were measured in 
the laboratory and in situ for both the sandy-soil fill and the undisturbed natural deposit around the pit. 

The stiffness and damping of the pile foundation are calculated for different base conditions. In the first 
case a nonlinear soil-pile system is assumed, and the boundary zone model is used around the piles. The 
parameters of the weakened zone are selected as: Gi / Go = 0.3, tm/ro = 1.0, β i =2 x βo . In the second 
case, liquefaction is assumed in the saturated fine sand layer, and the top layer of soft clay has not 
yielded. However, both stiffness and damping of these two layers are reduced to very small values due 
to liquefaction effects. 

As known, great amount of effort has been spent on the numerical analysis with 3D Finite Element 
Method (FEM) to model a soil-pile-structure interaction together. However, it is too complex, especially 
for the sub-structure (pile and soil) with nonlinear behavior. The computation time costs are substantial 
and the results are not reliable. The substructure concept based on the impedance function of 
foundations has been introduced in the structural analysis and is frequently used by the structural 
engineers for the time-history analysis in seismic studies. By means of the substructure method, the 
dynamic response of the superstructure (the vacuum tower) is analyzed using a nonlinear finite-element 
program, such as SAP2000 or other similar one, and the stiffness and damping of foundation generated 
by DynaN program being entered as the boundary condition, which represent the substructure in 
modeling. 
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The maximum amplitude of the vacuum tower will vary with each of the different foundation-soil 
systems (linear vs. nonlinear, with and without liquefaction zone). The natural periods of the structural 
vibration also have the similar effects from the assumed foundation condition as expected. 

Use SI units: kN, Mg, m. 

 

Figure 6.7   Pile foundation for dynamic response analysis demonstrated in Example 8 
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Table 6.1  Soil profile and properties for Example 10 

 

 

6.10.1 Input Data 
 

TITLE= OPTI VACUUM TOWER, Nonlinear soil 
MATRIX 
GRAVITY=9.8 
FOUNDATION=PILE 
RECTANGULAR=12,12 
MASS  
2288 29980 106600 118700 0 0 0 
LAYERS=8 
FIXED=25 
1 -5.5 -5.5  
2 -2.75 -5.5  
3 0 -5.5  
4 2.75 -5.5  
5 5.5 -5.5  
6 -5.5 -2.75  
7 -2.75 -2.75  
8 0 -2.75  
9 2.75 -2.75  
10 5.5 -2.75  
11 -5.5 0  
12 -2.75 0  
13 0 0  
14 2.75 0  
15 5.5 0  
16 -5.5 2.75  
17 -2.75 2.75  
18 0 2.75  
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19 2.75 2.75  
20 5.5 2.75  
21 -5.5 5.5  
22 -2.75 5.5  
23 0 5.5  
24 2.75 5.5  
25 5.5 5.5  
CONSTANTS  
0 -1.738 2.396 30 77  
150 0.3 0.02 1.2 2E8 
ELEMENT 
1 0.5 0.18 0.18 0.014 0.000303 0.000108 0.000832 
2 1.5 0.18 0.18 0.014 0.000303 0.000108 0.000832 
3 2 0.18 0.18 0.014 0.000303 0.000108 0.000832 
4 8 0.18 0.18 0.014 0.000303 0.000108 0.000832 
5 4 0.18 0.18 0.014 0.000303 0.000108 0.000832 
6 4 0.18 0.18 0.014 0.000303 0.000108 0.000832 
7 5 0.18 0.18 0.014 0.000303 0.000108 0.000832 
8 5 0.18 0.18 0.014 0.000303 0.000108 0.000832 
FLOATING 
INTERACTION  
SOIL  
WEAK 
CONSTANTS 
1 0 0 0.35 0.02 0.3 0.35 0.04 1 
2 130 18 0.35 0.02 0.3 0.35 0.04 1 
3 140 18 0.35 0.02 0.3 0.35 0.04 1 
4 300 20 0.4 0.02 0.3 0.4 0.04 1 
5 240 18 0.4 0.02 0.3 0.4 0.04 1 
6 300 18 0.3 0.02 0.3 0.3 0.04 1 
7 200 18 0.4 0.02 0.3 0.4 0.04 1 
8 300 20 0.4 0.02 0.3 0.4 0.04 1 
BELOW=370 21.5 0.4 0.02 
SIDE-CAP 
EMBEDDED 
2  
1 0.5 100 18 0.3 0.02 0.1 0.3 0.04 1 
2 0.3 80 18 0.3 0.02 0.1 0.3 0.04 1 
LOAD  
HARMONIC  
CONSTANTS  
NONQUADRATIC   
62.8 6.28 6.28 104700 0 27720 333400 417700 -673600 
RUN  
0 
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
 0.00000000000000E+0000  0.00000000000000E+0000  0.00000000000000E+0000  
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6.10.2 Output Results 
Only small portions of output are shown here.  Please run the example data file and view the complete 
output from the  computer screen. 
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